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1. Introduction 

What is Whirlwind WordSearch? 
Whirlwind WordSearch, a Macintosh word search (a.k.a. "word find") puzzle maker, lets you create and 
publish uniquely engaging word searches from your own word lists.  Many different shapes, sizes, fonts, 
alphabets/languages, and difficulty levels are supported.  You will be creating professional-looking 
puzzles right away. 

Add word searches to newsletters, web pages, or publish your own books.  Each puzzle you create is 
yours to distribute and sell, royalty-free; no commercial license needed.  Your puzzles and data stay on 
your computer.  No web-based accounts are ever needed. 

Choose from a large variety of built-in puzzle shapes, such as a circle, heart, diamond, crescent moon, 
pinwheel, and many more. Puzzles can range from as small as four letters across and down, to a puzzle 
50x50 letters, and 80x80 in the Pro version. 

You can easily increase or decrease the difficulty setting and create a new puzzle.  In response, the 
software automatically adjusts many subtle aspects of the puzzle for you.  This lets you quickly fine-tune 
them, creating different puzzles appropriate for anyone. 

Note: Some features are either not available or are limited in this software’s Lite version. In contrast, 
some features are more extensive in the pro version.  Those differences are indicated throughout this 
user guide. 

Whirlwind WordSearch has some elegant features that create 
high-quality “classroom-safe” puzzles. It double-checks every 
created puzzle and removes any randomly-created naughty or 
offensive words.   As you increase the difficulty setting, more 
tricks are added into the puzzle. Thus, a tougher solving 
experience is ensured. 

You can save your word search puzzles and open them later or 
send them to friends. You can also re-open the puzzles and print 
or export them. Moreover, you can quickly create new puzzles 
in different shapes and/or sizes from the same word list. 

Many puzzle features are customizable, including changing 
size or shape, colors, letter font, grid size, answer highlight 
style, export file formats, etc.  This user guide will explain all 
these options and offer new ideas for you to explore. 

Note: Sections of this user guide can be read aloud to you by selecting the text and choosing 
“Speech>Start Speaking” from the “Edit” menu. 
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2. Let's Make a Simple Puzzle 
This section shows you how to make and print a puzzle in just a few steps.  You will start a new puzzle, 
add some words, customize the puzzle’s appearance, generate it, and print it. 

1. Start: Find the Whirlwind WordSearch program in your “Applications” folder. Double-
click its icon to run it.  When it starts, it will open a new empty document.  “Untitled” 
will display on the screen in a window.  This document will hold your word list and its 
generated puzzle. 

2. Title: Tap the “Layout” and “Title” tabs. Then,  type in the title: “Furry Mammals." 

3. Add Words: Tap the “Words” and “Word List” tabs. Type some words into the “word list” box below.  
For now, just type in the following words: bobcat, wolf, bear, lemur, and gnu. Separate the words by 
either commas or new-lines. 

4. Difficulty: Tap the “Difficulty” tab. Choose “Basic” difficulty, and set the “Difficulty to Solve” slider 
to four. Setting it on four indicates a medium level of difficulty. 
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5. Size & Shape: Your longest word (bobcat) is six letters long. Therefore, your puzzle must be at least 
six letters across and down.  Tap the “Layout” and “Size/Shape” tabs. Set the “Puzzle Size” slider to 
eleven for some extra room. Then, choose a “Circle” puzzle shape.  

6. Build: Tap the “Build” button, located at the bottom right corner.  The Preview Area can display either 
your created puzzle, or the answer corresponding with the circled words.  A different puzzle layout is 
constructed each time you tap the build button. 

7. Print: Click the “Print” button at the bottom of the window to print the puzzle and answer pages.   

There it is!  Creating a customized word search puzzle is as easy as that! 

Oh, but wait… there is so much more you can do with Whirlwind WordSearch.  Keep reading and learn 
how to unlock many more powerful features. You will quickly be creating world-class word search 
puzzles. 
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3. Where Is Everything? 
This section gives you a quick overview of the software’s main areas and names used within this guide. 

3.1. Main Menu Bar 
When you start Whirlwind WordSearch, the main menu bar, located at the top of the screen, is replaced 
with menus for this software.  Within these menus are different actions you can choose that let you open,  
save, and close puzzle documents (just like using a word processor.) You can also customize the 
application’s behavior to set your own default values when you open new puzzle documents. Other 
commands allow you to start or stop building a puzzle. Additionally, you can bulk-build puzzles, or export 
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the created puzzle its answer files. You can also open this user guide or send me an e-mail.  A complete 
explanation of each command can be found in this later section. 

3.2. Document Window 
The document window has customizable settings for building a puzzle and its answer. These include 
constructing its word list, and choosing the puzzle’s size and shape.  It also displays a quick preview of 
the finalized puzzle and its answer.  This document can be saved as a file, and re-opened later.  You can 
open multiple document winddows at the same time and switch between them as you work on them. 

3.3. Control Tab Settings 
This section contains multiple tabs, that let you switch between different sets of controls.  The puzzle’s 
colors, fonts, sizes, and/or shapes, list of words, etc. are all customizable.   As changes occur, the Preview 
Area will update to show you how the puzzle appears.  Each control in the “Control Tab” area is explained 
in this later section. 

Note: Changing some controls will require the puzzle to be re-built, for example changing the puzzle 
dimension or shape.  When you update these specific controls, the Preview window will change and 
show an empty (un-built) puzzle.  You can then build again to create a new puzzle. 

3.4. Preview Area 
The Preview Area displays an image of your final puzzle and answer key. It contains the puzzle grid, its 
optional title and sub-title, and its word list. These will be displayed in the fonts and colors you have 
chosen from the “Control Tab.”  Extra check boxes at the top of the Preview Area allow you to display 
some extra information inside the puzzle that isn’t normally printed.  You can read more details about the 
Preview Area in this later section. 

3.5. Action Buttons 
Action buttons, located in the bottom right corner of the document window, provide you quick access to 
frequently used actions within the software.  These actions and others can also be accessed from the 
Action menu on the main menu bar. These include building a puzzle, printing/exporting a puzzle, or 
opening this user guide.  All these actions are accessible from the “Action Menu.”  Read more details 
about these buttons in this later section. 
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4. Help! Tell Me How To... 
Whirlwind WordSearch lets a new user quickly make a puzzle and print the puzzle without much work. It 
likewise offers the power-user many advanced features for generating high-quality puzzle graphics for 
newsletters, books, web sites, and other publications.  You will also begin to realize how powerful this 
software is, and how these high-quality puzzles will delight your audience. 

Now, many of you with different needs have often asked how to accomplish certain things.  I have written 
this section in response to your questions, hoping to offer step-by-step instructions for doing a variety of 
things with Whirlwind WordSearch.  If you don’t see your question answered here, please delve deeper 
into the next section. It covers every menu and control. 

4.1. Create a New Puzzle 
Each new puzzle you create contains a single list of words, and an accompanying puzzle configuration.  
It’s displayed in its own window. You can create, save, and work on different puzzle documents in this 
software, either one at a time or simultaneously. 

To create a new puzzle document, you can either: 

• Open Whirlwind WordSearch.  It will automatically create a new “Untitled” puzzle document. 

• If Whirlwind WordSearch is already running, or if it automatically opens a prior document you were 
working on, simply choose “New” from the “File” menu.  It will then open a new “Untitled” puzzle 
document. 

Now you are ready to enter your words, configure the puzzle options, print it, and save it. 

4.2. Save a Puzzle Document on Disk for Later 
If you have already entered a word list and customized the puzzle’s layout, save your work to a document 
(file) on your computer.  Then you can either open it or print more copies later.  Do this especially if you 
want to save your changes or want to share your puzzle with a friend who has Whirlwind WordSearch. 

Puzzles can be saved even if you've only entered some words but have not yet built a puzzle.  This allows 
you to quit the application, but then later return to the puzzle document to finish working on it. 

• After making changes to the document, choose “Save” from the “File” menu. 

• You will be prompted for a file name and directory location, depending if this was a new document 
or it was your first time saving it to disk.  Type in a file name, choose a location on your disk, and 
tap the save button.  The file has now been created. Your word list and puzzle settings are stored 
within it. 

• Alternatively, if you have opened an existing document to make changes, saving the document 
would quietly update it in place.  It would update the information and not prompt you for a file 
name.  

The saved document will look like this on disk: 
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The document will stay open after you saved it. Therefore, you can keep working on it. 

Note: The “File” menu has a menu item titled:“Open Recent.” This menu has documents you have 
recently worked on.  You can simply choose one of your recent documents here. It will re-open for you. 

4.3. Open my Saved Puzzle Document to Edit/Print 
• Using the Finder, locate the Whirlwind WordSearch puzzle document you want to open. 

• Double-click your document to open it with Whirlwind WordSearch. Conversely, choose “Open…” 
from the Whirlwind WordSearch “File” menu; then, navigate to the folder of the puzzle document 
you want. Select it and tap the “Open” button; or, open the document by dragging and dropping the 
puzzle document icon onto the Whirlwind WordSearch application. You can drop multiple documents 
at the same time. Each one will open in its own separate window. 

• Your puzzle should open and display in a window. It is identical to when you last saved it, because 
the application will re-build it upon opening.  If you had saved the file without first building a puzzle, 
re-opening it would leave the puzzle empty/unbuilt until you tap the “Build” button. 

4.4. Copying my Puzzle to a Different Document 
You may want to make a new copy of one puzzle document to edit without changing the original puzzle 
document. 

• Open the original puzzle document. (See this section link.) 

• Choose “Duplicate” from the File menu. (Do not choose “Save.” Choosing this option will write 
your changes into your original document.) 

• A second copy of the document window will open. Type in a new name for the document at the top 
of the window.  The newly copied file name must be different from the original document. 

• Make your changes in the new document’s copy. 

You have now “switched over,” and you are working in the new document copy.  This means that, when 
you make changes here and choose “Save,” these changes will be written to the new document and not the 
original.  The original document window is still open behind the new document. You can close it, or make 
other changes to it separately, since they are now two different files. 

4.5. Make a Very Easy Puzzle 
Very easy puzzles are likely targeted at an audience who is just learning to read.  You can set this up with 
the following options: 

• Select the “Word List” tab.  Enter a small number of short words in your word list.  Try three to five 
words. These words should be three to five letters long. 
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• Select the “Layout” tab.  Set the “Puzzle Size” to something fairly small, perhaps between six and 
nine.  Note: The larger the “Puzzle Size,” the smaller each letter becomes on the printed puzzle. The 
entire puzzle will automatically shrink to fit onto a page.  You may also want to choose a SANS-
SERIF FONT that is easier to read. Then, turn off the checkbox that instructs to “Print letters in 
lowercase.” 

• Select the “Difficulty” tab.  Slide “Difficulty to Solve” to either very easy or easy.   This setting only 
places words horizontally left-to-right or vertically-down.  It additionally fills the remainder of the 
puzzle with letters not in the wordlist. Ultimately, the puzzle is easier to solve. 

• Lastly, tap the “Build” button. 

4.6. Make a Very Hard/Tricky Puzzle 
Very hard puzzles are best suited for more skilled puzzle solvers. These can be set up with the following 
options: 

• Select the “Word List” tab.  Enter a large number of words, any where from ten to thirty words of 
any length. 

• Select the “Layout” tab.  Make the puzzle large, perhaps between twenty and thirty-five letters.  The 
larger the puzzle’s size, the smaller each letter becomes on the printed puzzle. The entire puzzle will 
automatically shrink to fit onto a single printed page. 

• Select the “Difficulty” tab.  Slide “Difficulty to Solve” to at least six (harder) up to eight 
(diabolically difficult.)  These settings place the words in any of the eight compass & diagonal 
directions, while the remainder of the puzzle is filled with letters from the word list.  If you choose 
one of the highest two difficulty levels, it will also sprinkle some partial pieces of your words into 
the puzzle as deceptive “decoy wordlet” patterns.  Read more about Decoy Wordlets here. 

• If you want to make the puzzle visually more unique and ornate, choose an UNUSUAL FONT under 
the “Layout Tab” in the puzzle letters group. Then, turn on “Print letters in lowercase.” 

• Or if you want very fine control over the difficulty settings, you can turn on “Advanced” Difficulty 
Mode. You cant then choose the word directions, overlap behavior, and decoy wordlet fill density 
yourself.  See the “Difficulty Tab:Advanced Difficulty Mode” section link. 

• Tap the “Build” button to build the puzzle. 

Sometimes Whirlwind WordSearch takes a long time to build a puzzle because the puzzle you designed is 
so complicated.  In these cases, as it builds a valid 
puzzle that matches your criteria for dimension, 
difficulty, layout, etc, it will display a progress bar in 
the middle of the window.  It works to find an answer 
that fits all the words, while also removing random 
duplicates and naughty words. 
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Note: If Whirlwind WordSearch is “busy generating” and you need to interrupt its progress to make 
changes, just tap the cancel button on this “Building your puzzle…” sheet.  The puzzle will stop 
building and you can adjust settings and tap the “Build” button again. 

However, if it still cannot fit all your words into the puzzle, it will eventually give up. It will display a 
helpful error message with suggestions on how to proceed.  If this happens, you can adjust some of your 
puzzle settings (different puzzle size, different shape, different difficulty, or fewer words). Then try your 
luck again. Tap the build button to try constructing it once more.  Each time you tap the Build button, it 
tries a different approach and creates a completely different puzzle each time. 

4.7. Print the Finished Puzzle to the Printer 
After you open a puzzle document and create a puzzle layout you like, it's time to print the puzzle and 
answer. You do not need to save your document to disk before printing; however, it is usually a good idea 
to save your work.  To first save before you print, follow the instructions in this section link. 

Go to the “Page Details” tab. Ensure that the “Print the Puzzle Page” and “Print the Answer Key Page” 
are turned on.  If both are turned off, or if you have not yet created a puzzle, then the “Print” button and 
menu item will be disabled. Essentially, there is nothing to print. 

You can now print by either: 

• Tapping the “Print” button at the bottom of the window. 

• Or choose the “Print...” item under the “File” menu, and tap the “Print” button. 

• Or tap the <Command>-P keys on the keyboard. 

Make any changes you need in the print dialog; then, tap the “Print” button. 

You could alternatively choose to save the puzzle and answer as a PNG or PDF files (for attaching to an e-
mail, for example).  See this section link for how to do this. 
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4.8. Export Puzzles for Publishing 
Your existing newsletter may be yearning for a puzzle page, or perhaps you want to add your own logo 
and text in fancy ways around a word search puzzle.  Perhaps you need to create a number of different 
puzzles, and lay them out and publish them in a book.  In these instances, you will want to extract just the 
puzzle grid image, the word list, and its associated answer grid image. You will need to arrange these 
elements yourself using a separate word processing document. Then, you can do your own page layout.  
There are a couple of ways to do this. 

Export Method 1: Direct Copy & Paste 
To quickly copy and paste these elements from Whirlwind WordSearch into your word processing 
document: 

• Using Whirlwind WordSearch, customize and build the puzzle that you want to use. 

• Choose the “Copy Formatted” item from the “Edit” menu. It will open a sub-menu of more options.  
These options let you copy either the word search puzzle grid or the answer grid as high quality PDF 
images to the clipboard. 

• If you want to keep the grid lines and colors and font style of letters, choose “Copy 
Formatted:Puzzle Grid as image" . 1

• If instead you are copying into another “table”, for example a spreadsheet grid, or another built-in 
grid like Canva, then you should choose “Puzzle Grid as text”, then select the upper left cell of the 
destination, and choose “Paste”, and it should sprinkle each letter into each grid cell for you. 

• You must copy the puzzle grid, answer grid, and word list separately.  You likely want to place the 
word list above, below, or wrapped around the puzzle with a different font size.  Moreover, you 
might want to place smaller sized answer grids at the end of the book.  So, keeping each puzzle item 
separate will give you this extra page layout flexibility. 

• Now, open your word processing or page layout application. Open the document where you want to 
add the puzzle. 

 You could also copy these elements by typing the keyboard shortcuts <Command>-<Option>-1, <Command>-1

<Option>-2 or <Command>-<Option>-3
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• Choose paste from your word processor’s “Edit” menu.  Move and resize the resulting puzzle to 
where you want to place it within your document. 

• Choose “Edit:Copy Formatted:Word List as Text” from the menu.  Paste this text into a textbox in 
your page layout software.  The word list will be formatted as you chose in the “Layout:Word List” 
tab regarding case, numbering, sorting, etc.  Its position, size, font, color, etc., are now changeable 
within your page layout software.  You can even wrap the words around the puzzle. 

This copy-and-paste process can be repeated to copy the puzzle's word list and answer grid into a word 
processing document.  If you are creating a small booklet of puzzles, you can easily build many different 
puzzles, and copy-and-paste the puzzles using this method. 

Here's an example of the puzzle dropped into a newsletter with an interesting background behind it: 
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NOTE!  Before we continue, there is something 
you should know about copying the puzzle.  This 
copied puzzle is a “vector object,” not a “bit-
mapped object.”  This is good news, and also bad 
news. 
The good news is that when you copy this puzzle 
into your word processor and resize it, the puzzle 
retains a crisp, high-quality look.  Rather than 
look fuzzy or blocky, it will remain sharp.  It also 
only copies the letters and lines; so the 
background will display nicely if you paste it 
over a texture. This is often what you want to 
see. (See the example to the left.) 
Although, because the letters and lines are thin 
and it is an object “full of holes,” you may find it 
difficult to click on a part of it to select it, move 
it, or resize it.  To remedy this, increase the 
magnification or “zoom level” in your word 
processor. This makes it easier to grab and move 
this object. 
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Export Method 2: Saving as Files 
For larger projects, you may want to adopt a more professional approach. This method saves these 
elements as high quality files, while organizing and sorting the word list in multiple ways for you. 

Note: Just like the “Edit:Copy” command above, the export command exports the puzzle or answer 
grid image.  The exported files will neither include margins, nor will they (normally) include your title 
or your word list. It is assumed you will be laying out these other elements on the page separately.  You 
can separately extract your word list by either (1) selecting the words in the word list text box and 
copying them, or (2) choosing “Edit:Copy Image of:Word List”, or (3) choosing “Edit:Copy Puzzle/
Answer as Text.” Paste the entire text block into a text editor, extracting the formatted ordered list of 
words.  In the PRO version, you can export the puzzle with its title and word list by choosing 
“including title and word list” from the top of the export window.  

Exporting gives you additional file format options, and higher resolution/quality options. These are useful 
when importing to other publishing software. After exporting, you can import those files into software 
where you can nicely format them for publishing.  For this more flexible work-flow option, here is how 
you can export the puzzle and/or answer grid to separate files. 

After generating a puzzle you like, export a copy of it by choosing the File:Export Files... menu item.  
You will be presented with an “Export Files” window, which has a variety of options. Here you can 
choose which items to export, their file format, their file names, etc. 
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As you change these settings, Whirlwind Wordsearch will remember them for future export sessions.  A 
box located at the top of the window will display the proposed filename and your chosen file dimensions 
and format.  These will change as you update any of the settings in the export window. 

Export the Puzzle File 
When you choose to export, it will always write the puzzle file.  You can optionally instruct it to write the 
answer file and others. 

[x] including Title and Word List (Full & Pro Feature) 
Normally only the puzzle grid is written out when you export the puzzle image’s file.  Later you will add 
your own title and subtitle, as well as the word list’s text around these puzzles.  However, if you turn on 
this checkbox, the exported puzzle file will be the same height but a narrower rectangle size. It will add 
the title and subtitle above the puzzle, placing the word list (and optional secret message prompt) below 
the puzzle. It will include the font, color, size, and formatting you specified in the “Layout” tabs.  This is 
more convenient if you're constructing multiple word puzzles for a book. Moreover, this implies that you 
are satisfied with Whirlwind WordSearch’s layout of the title, subtitle and word list for the puzzle.  Keep in 
mind, though, that this will only add the title and word list to the puzzle file; not the answer file. 

Note: The exported puzzle file layout will always be “Portrait Mode.” Titles will be listed above, with 
the word list below.  Export file layout is not affected by the “Printing Layout” tab to print puzzles in 
“Landscape Mode.” 

[x] And Answer File 
The puzzle file will always be exported, but here you can optionally enable writing the answer file too.  
The exported puzzle and answer files will have the same file names, with the added suffix of either 
“_Puz” or “_Ans.” 

[x] And Word List Text File (Pro Feature) 
Turn this on to export an “Config/INI”-formatted text file, using your formatted word list in multiple 
ways.  There is a complete list of words used, in the sort order and case you that requested in the “Word 
List” tab.  There are also lists of words grouped by the directions they were laid out in the puzzle.  
Furthermore, lists of words are grouped by length. This text file name will have the suffix “_Wrd.” 

[x] And ESP File (Pro Feature) 
This is a JSON-formatted text file that is easily imported into other computer software.  It contains all the 
puzzle and answer information needed to re-create the puzzle in other software.  These files can be 
imported into your publishing workflow to lay out a large number of puzzles where you will want them 
re-formatted and flowed onto pages in your own way.  Or they can be collected and imported into your 
own interactive game-player engine on the web or in your mobile app.  See the Help menu item “ESP File 
Guide” for detailed information about this file format. 

File Size and Format 
Size (width and height): The “Size” setting lets you choose how large the puzzle image will be when you 
export it.  This setting is only used for the image formats (PNG, JPEG, PDF, SVG.)  Any text-based 
formats (e.g., ipuz) don’t need or use it. 
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Note: There are fewer export sizes and file formats in the Lite version of this software. 
File Format: You can choose what export file format to use when saving your exported puzzles and 
answer grids. 

PDF: This is a high quality (vector) publishing file format, readable by many word processing and page 
layout applications. 

PNG, JPEG: These are graphic image file formats. These are readable by many photo and image editing 
programs, as well as word processors and page layout applications.  PNG supports transparency, 
JPEG does not 

SVG: This is a vector graphic file format. It can be re-sized without losing any quality.  Many web 
browsers, Amazon Kindle, and some page layout or graphic editing applications can read these 
images.  SVG files are non-interactive, but can be directly added to a web page, or imported and 
used to develop an interactive game. They may even be imported into CNC or 3D printing 
machines.  Let your creative imagination think about these possibilities!  It is important to note that 
SVG files, unlike PDF and PNG/JPEG files, cannot capture and use your computer’s fonts for 
drawing letters. Therefore, the fonts used in SVG files are a “suggestion” for what to use on the 
end-user’s computer.  You can change the font-suggestion for SVG files by selecting one from the 
SVG “Letter Font” menu under “SVG Info” in the Application Settings window. 

Text (tab-separated): This is a regular text file format, which will contain the puzzle or answer grid as 
multiple lines of text, with each line of letters separated by a Tab character.  The answer file will 
only have the letters of your words listed, and non-word positions will hold a blank space. 

Text (comma-separated): This is a regular text file format, which will contain the puzzle or answer grid 
as multiple lines of text, with each line of letters separated by a comma character.  The answer file 
will only have the letters of your words listed, and non-word positions will hold a blank space. 

File Naming 
File Name Text: This string will be used as the main part of all your export file names. 

Use Default File Name: If you saved the current document, this button resets the value of the “file name 
text” to the currently saved document's file name, otherwise it sets it to the generic “Whirlwind 
WordSearch." 

Add Export-Counter to Exported File Name: Turn this on to add an export counter into the file name 
that increments upon each export.  You can build multiple puzzles with the same puzzle setup, exporting 
each puzzle with a unique file name, e.g.; “MyPuzzle_1_Puz.png,” “MyPuzzle_2_Puz.png,” and 
“MyPuzzle_3_Puz.png.” 

Note: To display this counter in the title of your puzzles, see the puzzle-macro $$exportcounter in this 
linked section. 

…, Starting At: If “Add Export Counter..” is turned on, then you’re able to choose a starting value for the 
export counter mentioned above. For example, if you set this to 222 then, every time you start the 
application and start exporting, your first exported puzzle file will start with that export-counter value 
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(“MyPuzzle_222_Puz.png”).  Each time you export again, the subsequent files will get the next-higher 
export number, e.g., “MyPuzzle_223_Puz.png.” 

Note: You can reset the internal counter back to your starting value by simply re-typing the starting 
value in the text field. 

File Name Layout: This pop-up menu lets you format the exported file names with the above 
components in a particular order. Ultimately this will change how they are sorted and grouped in the 
Finder.  As you change this pop-up setting, the file name at the top of this window will update and show 
you the new layout. 

Add SPIN to file name: Turning this on will append the current SPIN number to the file name; therefore, 
exporting multiple generated puzzles from one document will have unique filenames.  They will only 
differ by the SPIN; where the words got placed.  The SPIN will always be placed at the end of the file 
name. 

Destination Directory 
Choose Directory for Export Files: This lets you pick a directory to write all your exported puzzle/
answer files. 

Reveal Directory in Finder: After you have chosen a destination directory, tap this button to open and 
display it in Finder.  This is a quick way to access the exported files. 

Warn if about to overwrite existing files: This warns you if you’re about to overwrite an existing file. If 
export finds a file with an identical file name, it will pop up a dialog.  This allows you to either overwrite 
or skip this one or all duplicate files. 

Once you have set the export options, tap the Export button at the bottom of the window, and the 
appropriate files will be written to the destination directory you chose.  If there are any problems, an error 
message will be shown near the bottom of the window, otherwise the window will automatically close 
when complete. 

Note: The changes you made inside this export window are now saved with the document you have 
exported.  If you now Save your document, they export options will be saved there too.  If you want to 
keep these changes for new future puzzle documents too, then you can now choose “Save document 
settings as defaults” from the Whirlwind WordSearch menu, and these export settings will also become 
the default for all new documents you create. 
Note: You may want to save each puzzle document once you like it, in case you need to open it later 
and change and re-build and re-export the files… you know, in case one of those eagle-eyed editors 
requests a minor change. 
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4.9. Spellcheck the Words as They Are Entered 
There is a built-in spellcheck, which checks words in many different languages.  To enable this,  open the 
“Edit” menu on the top menu bar.  Select “Spelling and Grammar” to see the options. 

These menu items offer you a visual indication of misspelled words you typed, either 
in the word list or in the secret message text areas. It further checks for misspelled 
words in the title and subtitle text areas.  You can select and turn on “Check Spelling 
while typing.” After doing so, you will see a red underline under words that the 
dictionary does not recognize. 

4.10. Design Your Own Puzzle Shape (Pro Feature) 
You can design your own shape, and build a puzzle with it! 

First, select the “Layout” tab.  Next, choose “Design  
Your Shape” under the “Size/Shape” tab in the Puzzle 
Shape box. Then, tap the “Launch Shape Editor” button.  
You can also create a shape by going to the top “Action” 
menu and choosing “Shape Editor.” 

The “User-Designed Shape Editor” sheet is now 
presented on top of your current puzzle document. It lets 
you design or edit your own shape for this puzzle. 

Make a company logo, an animal, a tree, a holiday shape, 
or just about anything you can imagine.  The "Shape 
Editor” lets you draw the shape in large puzzle resolution 
(50x50) in the “Design & Edit Here” grid on the left. It 

also shows you a preview of different puzzle sizes in the “Preview Here” grid on the right.  If you make a 
mistake while drawing, erasing, or filling the design area, choose “Undo” from the Edit menu. It lets you 
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back up a step or more.  Opening the “Shape Editor” from a document with an already-created user-
designed shape allows that shape to load into the program. Therefore, you can easily edit it.  There is only 
one user-designed shape in each Whirlwind WordSearch document. 

Note: Every edit action you take in this sheet is “undoable.”  You can switch pen size and draw a few 
strokes.  If you don’t like the strokes you made you can undo those changes, which essentially “steps 
back” to prior versions of your shape.  Simply use the “Undo” menu item under the “Edit” menu to 
undo each change you made. 

Shape Name: & Designed By: 
Add a “Shape Name” and add your name/copyright to the “Designed by” text fields. They will be saved 
with the shape if you export the shape file. 

Design & Edit Here 
Pen Size (Radius) 
This lets you change the pen size with which you draw or erase.  The left side makes you draw smaller, 
while the right side lets you draw larger. 

Display Some Ruler Guides 
Turn this on to display faint ruler lines inside the design grid, thereby helping you line up your drawing. 
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Mouse Drawing Mode: Fill/Erase 
You can select the mouse-dragging behavior to either draw or erase. Drag the mouse around the “Design 
and Edit” grid with the mouse button down to make your shape. 

You can hold down the <Shift> key while drawing to “lock into” horizontal & vertical axis lines. 

You can hold down the <Option> key while drawing to “lock into” diagonal axis lines. 

Fill Shape: & Erase Shape: 
You can completely fill or completely erase the shape area with these buttons. However, when you click 
these buttons, you will first be asked if it is OK to wipe the shape clean. 

Fill With: <Geometric Shape> 
The shape area can be filled with a pre-defined geometric shape, which makes it easier to create your own 
custom shape. When you select a shape from the pop-up menu, you will first be asked if it is OK to wipe 
the prior shape clean. 

Preview Here 
Puzzle Preview Display Size 
Moving the “Puzzle Preview Display Size” slider to different sizes shows hows how the puzzle will 
appear.  This lets you fine-tune your drawing so it works well at a specific dimension/ range. 

Import 
This button loads a “.ssuds” shape file into the current shape window. 

Export 
This button saves a copy of your current shape as a separate “.ssuds” shape file.  It can be imported later 
into this software, or other software products that read this file format. 

Save/Cancel 
Save 
Save your shape design back into your currently-opened document.  
You can now make puzzles from it.  Once saved, the "Shape Editor” 
sheet closes and the shape you have designed is shown in the 
“Preview” window.  If you then save this document to disk as a file, 
your user-shape is saved inside it as well. It will be available when 
you re-open this document later. 

Cancel 
Throws away your current edits, closes the “Shape Editor” window, 
and leaves the document’s existing user-designed shape unchanged. 
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Exported “.ssuds” Shape File Format 
Upon exporting your user-designed shape, it's saved in a special file format that can be read/imported by 
any other SchwanSongs software supporting this format.  Currently the only two SchwanSongs software 
applications that support this format are Minos Maze Maker Pro and Whirlwind WordSearch Pro. 

The “.ssuds” file extension stands for “SchwanSongs User-Defined Shape.”  The file itself is in XML 
format, specifically an Apple .Plist file format.  It consists of a dictionary of key-value pairs. These define 
the version of the file, the name/credit strings, width/height dimensions, and the actual two-dimensional 
bitmap of the shape in Base64 encoding.  If you are interested in parsing this yourself, e-mail me a 
request.  I can send you the specification details. 

4.11. Remember Your Current Settings as “Default” for Future Puzzles 
You may find that every time you start the software, you always go in and change certain settings the way 
you like.  You would prefer that the software to remember your custom settings and open every new maze 
for you this way.  Whirlwind WordSearch can do that for you! 

Simply open a document and change all the settings to you want all documents to start with, and then 
choose “Save as Default Settings” from the Whirlwind WordSearch menu.  It will remember every setting 
(size, shape, difficulty, colors, page title and font, etc.) and use them for every subsequent new maze. 

Any time you want to change these “default” values, simply do those steps again and it will update and 
use your new settings. 

4.12. Make Several Groups of Similar-Looking Puzzles 
You may want to set up multiple “default” settings and be able to quickly switch between them, to create a 
group of puzzles that all look similar.  For example, you may be creating a book of puzzles with three 
sections, EASY, MEDIUM, and HARD.  You want eleven EASY puzzles of easy difficulty and smaller 
size, and nine MEDIUM puzzles of medium difficulty and moderate size, and eight HARD puzzles of 
harder difficulty and a large size. In this case, it is best to create and save three separate puzzle documents, 
each with its own settings.  These puzzle documents can be thought of as “template” files that each hold 
particular settings for a group of puzzles. 

For the above example, simply create, update and save a first puzzle document with the EASY settings for 
the first eleven puzzles. Then, create and save a second new document (you can duplicate the EASY 
puzzle file from the File menu or in the Finder, and rename the copy to MEDIUM, for example) with the 
MEDIUM settings, and create a third document for your HARD settings.  Now you can open the first 
EASY document and create and save eleven EASY puzzles from it.  Next, open the MEDIUM document, 
and make nine different MEDIUM puzzles from it, and open the HARD document and make eight HARD 
puzzles from it. 

Note: If you are using the Pro version of the software, you could instead open the EASY document and 
choose “Bulk-Builder” to set up and automatically make the eleven EASY puzzles, then do the same 
with your MEDIUM and for the HARD documents.  See this linked section for the Bulk-Builder. 

____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs24 102

http://www.schwansongs.com


4.13. Reset your document’s settings to saved “factory defaults” 
If you have made a bunch of changes to your document but now want to quickly restore all its settings to 
the saved default set of values, there’s a menu item for that!  Choose the menu item “Reset Document 
Settings to Defaults” under the Whirlwind WordSearch main menu. After you choose this, your currently 
opened document settings will all revert to the currently saved “default” settings for this software. 

4.14. Solve a Puzzle On-Screen Without Printing It 
There are times when you may want to create a word search puzzle just to work on without printing it.  In 
this case, you do not want to see the answer, but just the puzzle.  This is easy to do. 

• First, change the “Preview as” style at the top of the 
“preview area to “Puzzle.” 

• Next, turn off all the checkboxes in the preview 
area (above the puzzle display). These display extra 
indicators on the puzzle. 

• Now add your words and build a word search 
puzzle.  It will be displayed on-screen without the 
answer key or any other hint lines added. 

• Once you have visually found all the words, or if 
you need  to peek at the answer grid for a hint, 
change the “Preview Display:” style to “Answer,” 
and the answers will all be shown.  Switch it back to 
“Puzzle” to hide the answers. 
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4.15. Copy a Word List from a Web Page (or Document) into a Puzzle 
There are many places to get lists of interesting 
words for a word search puzzle.  You may already 
have your own list of words in a word processing 
document, or you may want to find a list of words on 
the internet.  Simply follow these steps to get a list of 
words from somewhere else into your word search 
puzzle. 

• Create a new puzzle document, as described in 
this section link. 

• Now find and open the word list you want to 
copy from, either on the web or another 
document. 

• Open your word processor, and open the 
document containing your list of words. 

• Alternatively, do a search on the web for “free 
word search” or “vocabulary words.” Find a site 
that provides a list of words that appeals to you.  Many 
non-copyrighted word list collections are freely available 
for you to use. 

• Let's say we are studying food-related words starting with 
the letter “H.” We have found the following word list from 
a web browser: 

• In this browser window, click above the upper left of the 
word list. Drag down to the lower right, selecting the list 
of words you want to copy. (See the blue selection above.) 

• Next, choose “Copy” from the “Edit” menu. 

• Switch back to Whirlwind WordSearch. Tap the “Words” 
tab and click inside the “Word List” box. Next, choose 
“Paste” from the “Edit” menu.  The words will show up in 
your word list area.  You can now edit your word list, 
adding or deleting words to suit your needs. 

• Tap the “Build” button, and you have a word search puzzle ready to go! 

Note 1: The words must be separated by commas or new lines after they are placed in the Whirlwind 
WordSearch “Word List” text field.  If they are not, you will have to reformat them after you paste them 
in.  The list is now be ready to be used for creating a puzzle. 
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4.16. Create Automatic Word Lists with Apple Intelligence 
You can also now directly fill the word list with relevant words using Apple’s latest “A.I.” feature, if you 
are running an Apple Silicon Mac with Mac OS Sequoia (15.2) or later, and have Apple Intelligence 
installed and enabled. 

Note: You can quickly determine if you have it by running your System Settings application, and 
looking for it here: 

• With your word search document open, select the “Words:Word List” tab. 

• Make sure there are no words in the word list text box, and click inside the word list text box to 
place the cursor there. 

• Now select “Compose…” from the “Edit:Writing Tools” menu. 
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• You can now type a short text prompt describing what words you want to automatically fill the word 
list text box.  For example, you could type “12 short words related to snowy weather.” 

• After a moment, the word list text box will automatically fill with the words that you requested.  You 
can then add to, delete, or edit this list of words. 

4.17. Automatically Use the Most Words Possible from a Big Word List 
Perhaps you want to copy or type in a large list of words. Let the software pick the largest number of 
those words which would fit into your puzzle’s size and shape.  This is possible by tagging some or all of 
your words as being “optional.” Meanwhile, have Whirlwind WordSearch use as many words as it can to 
make a puzzle. 

• If you want to control which words are required, and which ones could be optionally left out, you 
can individually mark each word you want to be optional by prefixing it with a '+' character.  These 
marked words will then be considered “nice to have” in the puzzle. Essentially these are not required 
if they don't fit.  As the puzzle is created and there are too many words to fit into the puzzle you 
chose, it will begin removing your optional words.  Then, it will try building the puzzle again.  When 
choosing which optional word to remove, Whirlwind WordSearch will find the longest optional word 
to remove first.  This guarantees that the fewest number of optional words will be removed before it 
can successfully make a puzzle.  It will remove more optional words, one at a time, and retry until it 
is successful.  If it has removed all the optional words and still cannot build the puzzle, it will then 
issue an error message that it “could not build the puzzle even after dropping all your optional words 
from the list.”  If this happens, you could either make more words optional, or increase the size of 
the puzzle. 
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• If you want to make all the words optional, and just see 
which words it can fit, you can instead turn on the 
“Make all words Optional in word list” checkbox. It’s located under the “Word List” tab.  This will 
treat all of your words as optional, and it will fit as many as it can. 

• If any optional words were dropped when the puzzle was made, you can view the list of them by 
clicking the “Show Removed 'Optional' Words” button. It will appear near the top of the Preview 
display after a build whenever there were optional words that were removed. 

Clicking that button will display a window 
that lists which words were removed upon the 
puzzle’s creation. You can click on and select 
these words and copy them from the sheet, in 
case you wish to paste them into another list 
or puzzle. 

You can also visit the “Stats” tab  (see this section link) to see the “# of optional words removed.” 
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4.18. Create a Puzzle in a Different Language 
Whirlwind WordSearch can create word search puzzles in many different languages… not just English or 
the language your computer is set to use.  This makes it easy for you to make puzzles for foreign language 
vocabulary studies. 

• First you must tell Whirlwind WordSearch 
which alphabet/language you want to use for 
your puzzle.  Select the “Words” tab; then the 
“Alphabet/Numbers” tab. Next, choose the 
alphabet/language you want to use from the 
pop-up menu. Choosing the alphabet does 
several things:  It selects which alphabetic 
letters are allowed in your words. It also tells it 
which letters with which to fill the rest of the 
puzzle.  It additionally tells it which language's 
“naughty words” to look for and remove from 
the puzzle.  You have now switched Whirlwind WordSearch to expect your words to use a new 
alphabet/language. 

• Next, you need to tell your Macintosh to let you 
type the letters from this newly chosen alphabet.  
To do this, first open the “System Preferences” 
panel in your dock.  Choose the “Language and 
Region” item, and add the language you want 
from the “Preferred Languages” (or older “Input 
Sources") list.  Either drag the one you want to 
the top of the list, or if it isn't listed, tap the [+] 
button at the bottom of the list to add it first. 

• To make an easy shortcut to switch languages, 
open the “Keyboard” tab in the “System 
Preferences” panel. Under the “Input Sources” tab, turn on the “Show Input menu in menu bar” 
option at the bottom of that tab. 

• Now, from the menu bar at the top of your screen, choose the same input language for your computer 
that you chose in Whirlwind WordSearch for your words. 
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This will allow you to type letters in that alphabet.  Now, click in the word list box of Whirlwind 
WordSearch. Start typing in this new language. 

When you are finished, you can switch back to your regular keyboard language again via the “Input 
Menu” you just added. 

4.19. Add a “Secret Message” Within a Puzzle (Full & Pro Feature) 
An interesting variation you can add to your word search puzzles is laying out a message in the remaining 
spaces in-between the word list’s words.  That way, after all the words have been found and crossed out, 
some or all of the remaining letters will spell out a message you have provided. 

Select the “Words” tab and the “Secret 
Message” tab. Type your message into the 
text box.  If it’s left empty, a secret 
message won’t be added to the puzzle. 

The secret message begins on the left-
handed side of the puzzle, while the letters 
are always laid out left to right. The letters 
appear line by line down the puzzle, 
skipping over any puzzle words, until the 
entire message is added to the puzzle.  If 
your message does not completely fill the puzzle, then the remaining puzzle spaces around it are filled 
with extra letters, just like a regular word search puzzle.   Only the alphabetic letters of your typed secret 
message are used.  Any punctuation or spaces or letters that are not in your current alphabet are 
automatically skipped or removed. 

Optionally you can add a prompt on your printed 
puzzle page, alerting your reader to look for your 
secret message.  To enable this prompt feature, select 
the “Printing” and the “Puzzle Page” tabs. Type a 
short hint to print on the puzzle page beneath your 
puzzle.  You may want to type something like “Find 
the secret message too.” 

To help you see where your message will appear, it 
can be displayed in the “Preview” area with a darker 
gray background. Therefore, it is easier for you to 
see where it is positioned.  Show the preview answer, 
by turning on “Preview as: Answer” at the top of the preview area.  Then in the “Preview” area, turn on 
“Show secret message.”  This gray box can display and highlight the final printed answer grid in your 
exported and/or printed answers. To bring it up, select the “Printing” and “Answer Page” tabs and turn on 
the checkbox: “Show the secret message on the answer page.”  

To add your own secret message to a puzzle, do the following: 
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• Create a new puzzle document, as described in this section link. Add bobcat, wolf, bear, lemur, and 
gnu to the word list. 

• Now, “hide” the message “furry mammals” in the rest of the puzzle.  Tap the “Words” and “Secret 
Message” tabs, and type “furry mammals” into the text box. 

• You can additionally choose the “position” pop-up menu. This changes where the message shows up 
in the puzzle: at the top, at the bottom, centered in the middle, or at a random position.  You can even 
require it to exactly fill every additional empty space in the puzzle. 

• Now, use the “Layout” and “Difficulty” tabs to set the size and difficulty and shape of the puzzle.  

• Lastly, build the puzzle. 

If Whirlwind WordSearch can successfully fit your words and your secret message in around the words, it 
will display the “Puzzle Preview” with darkened squares. This indicates where your secret message was 
added. 

If your secret message is too long for the puzzle and its quantity of words - meaning that there was not 
enough free space to add the entire message - then the puzzle will not be generated. Should this occur, you 
will get an error letting you know of the problem and hints on how to fix it. 

If you chose to “Exactly Fill” the secret message text, the 
software will lay in all the words. Then, it will attempt to 
lay out your secret message and exactly fill all remaining 
spaces in the puzzle.  If the secret message is too short or 
too long, however, you will see an error message. It will tell 
you how many letters to either add or remove.  You can 
then change the puzzle size or shape, word overlapping 
behavior, the length of the secret message, or add/delete 
word list words. You can also re-create the puzzle until you get it just right.  As you type letters in the 
secret message box, an “approx. space remaining” prompt displays below the text box. It shows how 
much space you have left. 

4.20. Build Many Different Puzzle Layouts from the Same Word List 
You might wish to use a single word list and create numerous puzzles from it.  Perhaps you are passing 
them out in a classroom and you want to discourage cheating, or you may just want to add variety by 
choosing different shapes for each.  The technique assumes that you wish to quickly print a bunch of 
different puzzles and their answer grids from a single word list.  This can easily be done. 

• Create a new puzzle document, and type in your word list. 

• Make all your initial set of changes in the different tabs to set up your first puzzle. 

• Tap the “Build” button to make your first puzzle. 

• Next, choose “Print” from the File menu. Print this puzzle (and its corresponding answer if you 
chose that setting.) 
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• Now make the changes you want to set up for the next puzzle. Change its shape, or simply tap the 
“Build” button again to create a different puzzle layout. 

• Go to the “File” menu and choose “Print” again. Print this new puzzle. 

Repeat these last two steps, changing the puzzle and printing again. Do this as many times as you need.  
Note that each puzzle and answer page you print will share the same “Specific Puzzle Identification 
Number” (SPIN) printed at the bottom of the puzzle and answer page.  This lets you match up the puzzle 
and its associated answer grid. 

4.21. Add a Word in the Puzzle that’s not Shown in the Word List (Full & 
Pro Feature) 

There are times when you may want to put extra words into the puzzle 
without having them show up in the word list.  For example, you may want to 
add several “unlisted” bonus words in the puzzle, giving extra credit for those 
who find them.  Or, you may want to add your name or company name in 
there as a kind of “copyright watermark.”  This is easy to do. 

• Simply put an asterisk “*” at the beginning of a word (with no space 
between the asterisk and the first letter). By doing this, that word will 
become “hidden” in the word list.  It will be placed in the puzzle, but 
will not show up in the printed word list or in the answer grid.  For 
example, if you wanted the word “wookie” to be in the puzzle, but not 
show up in the printed list of words to find:  lemur,  gnu,  bobcat, *wookie,  wolf,  bear. 

• The hidden words are normally not shown/circled on the answer key page.  However you can instead 
choose to have your hidden words shown on the printed/exported answer page.  For example, you 
may want to temporarily do this and print a single master answer key just for yourself, showing all 
the words, regular and hidden.  To do this, simply select the “Printing” and “Answer Page” tabs. 
Turn on the checkbox labeled: “Show 'regular' hidden words in the answer page.”  Any “hidden 
words” in your word list (Wookie, from in the example above) will then show up in the printed 
answer key with a light gray highlight under them.  Remember to toggle it back off if you later want 
to print the answer key without them shown. 

If you want to see how the hidden words are placed on the Preview screen, but you do not want to see the 
words highlighted on the final printed/exported answer page, then turn off the “Show Regular Hidden 
Words in the Answer Page” checkbox. Instead, turn on the “Show Hidden Words” checkbox under the 
Preview area. 

Tip: You can quickly hide/remove any of your words by prefixing them with an asterisk, wherever they 
are in your word list. This could also be used to create several different customized puzzles from a 
single large word list, just by moving the asterisks to different sets of words and re-creating a new 
puzzle.  Although they are not listed in your final word list, they are still placed in the puzzle. 

If you find yourself wanting to have a certain hidden word (or words) always added to all of your puzzles, 
you can do this by adding the words via the “Extra-Hidden-Words” pane of the Settings window.  This is a 
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simple way to add a “Watermark Word” to all your puzzles to dissuade copy-theft.  See the section, 
Settings:Extra Hidden Words for more information. 

4.22. Add Compound Words with Spaces/Hyphens/Apostrophes 
Sometimes you may need to add a single “compound word” (words composed of multiple words). These 
are normally separated by a space, hyphen, or apostrophe (sometimes called a “single quote character.")  
In the printed word list, you would want the compound word displayed with the space, hyphen, or 
apostrophe.  However, inside the puzzle, you want the non-alphabetic character removed. Consequently, 
the letters would have to run together along the same line. 

For example, consider the hyphenated word X-RAY.  This word will show the hyphen in the printed word 
list as “X-RAY,” but will be hidden inside the puzzle as “XRAY.”  The hyphen will be left in the word for 
display, and removed when it is put in the puzzle. 

If your word has an apostrophe ('), for example, O'Hara, then the apostrophe will be left in the word for 
display. The apostrophe will be removed when it is put in the puzzle, treated just like the space or hyphen.  
Note that it must be the regular apostrophe, and not a “smart/curly” single-quote character which word 
processors often use. 

Finally, to allow a compound word (or phrase) containing spaces, Whirlwind WordSearch requires that 
you separate each “word” in the word list with either a comma or a new line.  It will collect all the letters 
and spaces in-between, treating it as a single compound word or phrase.  For example, to use the 
compound word “blue jay” as a single word, enter it as “blue jay” in your word list. It will display as 
“blue jay” in the printed key, and and will be “BLUEJAY” in the puzzle. 

Note: You can even create a word search puzzle of entire phrases instead of single words by separating 
each phrase with a new-line or comma, e.g. “Stanley Kubrik, It’s full of stars” would become the two 
phrases “Stanley Kubrik” and “It’s full of stars”. 

4.23. Include Numeric Digits in Your Words 
Sometimes you want to add words that include numbers in them, for example “Route 66” or “Club 33.” 

To add these “Arabic digits” to your words without having the numbers flagged as errors, you must open 
the “Alphabets/Numbers” tab. Turn on the “Allow Numbers in Words” checkbox.  That’s it! 

Note: If you have chosen either of the Japanese alphabets, then you are additionally allowed to add 
Kanji numbers (i.e., 零一二三四五六七八九十百千万億兆) to your words as well. 

4.24. “Lock” the Word Layout While Changing Other Puzzle Aspects 
Consider this scenario. You created the perfect puzzle layout and the answer key is sent out; however, 
your editor now wants you to change the font used for the puzzle letters. Or, they would like you to show 
(or remove) the grid lines or some other aesthetic change, and re-print the puzzle. 

This can be done.  You can retain the layout of the words while changing many different aesthetic aspects 
of the puzzle. The same layout of the puzzle can be re-created.  Here's how. 
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Once you have generated a puzzle you 
like, and want to lock the words into 
place, simply go to the “Layout” and 
“SPIN” tabs. Near the bottom, click 
“Lock down this SPIN.” 

This will lock in and keep using the 
current SPIN value used to build this 
puzzle.  It can now re-use the same word 
layout pattern for all your future puzzles, 
no matter how often you tap “Build." 

Now you can change display-related 
options such as your puzzle’s title/subtitle, 
puzzle letter font, the secret message’s hint style, or the grid display. Then, re-create the same puzzle. 
Your word search words will still be in their original place, based on that unchanging SPIN value. 

Note: If you change the puzzle’s size, shape, difficulty - or change any of the words or secret message 
text or secret message position - the puzzle must change its layout even though the “SPIN” is still 
locked.  Whirlwind WordSearch re-checks the new words or secret message text. It must find new 
places for them to guarantee no accidentally created duplicate or naughty words snuck into the new 
positions.  That “locked” SPIN will now refer to this new puzzle layout. 

4.25. Build a Number Search Puzzle 
You may want to build a more challenging puzzle, by making a puzzle consisting only of 
numbers.  

First, select the “Words” tab. Underneath it is the “Alphabets/Numbers” tab. Choose 
“Numbers (Arabic)” from the pop-up menu. 

Enter your list of number sequences into the word list, each on a new line.  The 
rules for lists of numbers are the same for lists of words.  Each must be at 
least two characters long, cannot have duplicates, and cannot be longer 
than the puzzle dimension.. 

Choose the rest of the puzzle settings, like font, color, and difficulty. Then, tap the “Build” button, and 
Whirlwind WordSearch will make a numbers-only puzzle. 

Note: You can allow duplicates or one-digit numbers. Turn on both the “allow duplicate/mirrored” and 
“allow one-letter words” checkboxes under the “Word List” tab. 
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4.26. Build a Color-the-Letters Puzzle (Full & Pro Feature) 
One popular word search puzzle style draws the letters as outlines, so the puzzle solver can find the words 
and also color in the letters as they go.  You can create this kind of puzzle in the following way. 

• Under the “Layout:Letters” tab, choose a Letter Font that is fairly thick/bold, so there is space inside 
each letter to color. 

• Change the Letter Color to be white. 

• Turn on the checkbox “Draw Letter Outlines in color:”, and set that color to be black. 

• Increase the “Outline Thickness” to whatever width you want the outline to be.  As you make each of 
these changes on the left, the preview on the right will immediately update and show you how the 
puzzle will look. 

You may also want to set the Answer highlight to look good with this puzzle style.  You can do this by 
selecting the “Printing:Answer Page” tab, and under “Answer Highlights”, changing the “Highlight Style” 
to “Solid Oval” and the color to dark gray. 
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4.27. Build a “Word Clues” Puzzle (Full & Pro Feature) 
You may want to build a puzzle of words, but 
instead of printing the list of searchable words, you 
instead want to print a “word clue” phrase for each 
word.  The user would then have to guess the word 
from the clue, and find the word in the puzzle. This 
makes the puzzle a tougher challenge.  It further 
makes a word search puzzle more akin to a 
crossword puzzle.  Note that, although the puzzle 
words must be composed from letters of the chosen 
alphabet, the word clue phrases can be any text in 
any alphabet or language.  This allows for some 
creative puzzles.  For example, offer the clues in a 
completely different language, offering a fun 
language-learning puzzle. 

To start, you must enter each word and its 
associated clue together on a single line.  The word 
comes first, followed by a colon character ( : ). 
Then, add the word's clue phrase, followed by a 
new-line.  For example: 

Choose the rest of your puzzle settings. Tap the “Build” button, and Whirlwind WordSearch will make the 
puzzle with your words, as usual. 

Under the “Layout” and “Word List” tabs, tap the radio button 
“Word Clues” inside the “What to Display in the Word List” 
box.  You will need to add some word clues in your word list 
for this option to be available.  Selecting this changes how the 
word list will print/export, and does not affect the generated 
puzzle.  When you print the completed puzzle, it will now print 
your clues instead of your words on the puzzle page.  Note that 
on the answer page, both the words and clues will be combined 
and printed together. 
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If you add clues to one or more words, then all your words must have clues.  If you forget to add a clue to 
the end of one of your words, you will get an error that highlights the word just after where you forgot to 
add the clue. It looks like this: 

Note: There are always exceptions.  For example, If you have hidden words added to your word clue 
list, they do not need word clues added to them because they will never be displayed in the word list. 

4.28. Save the Puzzle Page as a PDF File for E-mailing or Printing 
What if you want to save your nicely laid out puzzle and answer pages as a file?  Maybe you want to take 
the puzzle to a copy/print center to get color copies printed.  Perhaps you want to send it to somebody else 
but they do not have this software.  Here’s how to save the puzzle and/or answer pages as a PDF file, 
readable by any other computers: 

• Set up and create your puzzle. 

• Under the “Printing” tab, turn on “Print the Puzzle Page.”  Next, turn on “Print the Answer Page” if 
you want to print the answer too. 

• Choose “Print” from the File menu. 

• Tap the PDF pop-up at the lower left corner of the Print dialog. 
Choose “Save as PDF” from the menu. 

• Pick a file name and location. It will write the two printed pages as 
a single two-page PDF document. 

Note: If you want the puzzle and answer pages each saved as separate PDF documents, do these steps 
twice. First print only the puzzle page to PDF, and then print only the answer page to PDF. 
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4.29. Remove Diacriticals from Puzzle Letters 
Many languages use special letters with diacritical marks on them.  These are needed to allow you to spell 
the words properly.  Whirlwind WordSearch normally leaves your word’s diacriticals intact when they are 
added into the puzzle, since removing a diacritical can often change the meaning of the word.  However, 
people using certain languages expect all diacriticals to be removed when making their word search 
puzzles .  So, here is how you can remove the diacriticals from the puzzle to make it “cleaner” looking: 2

• First, set up your puzzle. Add your word list words properly spelled with their diacriticals intact.  
This will ensure that they are displayed properly with their 
diacriticals in the word list. 

• Under the “Layout” and “Letters” tabs, turn on the 
“Remove all diacriticals from letters” checkbox. Changing 
this checkbox does not immediately show any change in 
the puzzle.  The puzzle must be re-built after this change.  
Also, note that the word list will always show the 
diacriticals intact. 

 For example, Italian word-search publishers!2
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• Optionally, to be extra tidy, choose “Advanced Difficulty Mode” under the Difficulty tab. Choose to 
fill the puzzle with “Only your fill-letters….”  Then look at the “fill-letter subset” letters at the very 
bottom of the advanced box. Delete any letters in the box that you do not want used as random fill 
letters. 

For example, change it to look like this: 

Now, when you create the puzzle again, none of your words or the extra fill letters will have diacriticals in 
the puzzle. 
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4.30. Bulk Build Many Puzzles at Once (Pro Feature) 
Bulk building is most useful for creating a large number of word search puzzle image files that you will 
later import and arrange into your own book, newsletter, or web page. 

When you choose “Bulk Builder” from the “Action” menu, a sheet is presented on top of your current 
puzzle document.  This sheet lets you configure and then automatically build a large number of different 
puzzle and answer files. Bulk Builder will then save all the completed files in a directory you choose.  
These files will be the exported image files, and optionally other informational files you choose to export. 

Designs 
Here is how the “Bulk Builder” works.  Let’s say you want to quickly make ten different puzzles, each 
with a different word list.  I will call each of these ten puzzles it creates a “design.” 

Variations 
For each of these designs, you can optionally have it build one, two, three… up to five different 
“variations” on that puzzle design.  In other words, for each design, it will re-build that same puzzle (with 
the same word list) and save it as a new variation. It’s as if you simply tapped the build button again to get 
a new layout of the same puzzle .  For example, if you ask for three variations of each design, it will 3

generate your ten designs with three variations each. There will be a total of thirty (ten times three)  

 As you know, sometimes a second or third “re-build” of a puzzle gives a much better layout, and this allows you 3

to make several layouts (variations) and then review and choose the best one after they are all built.
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different puzzles for you.  This lets you review and choose your favorite variation for each puzzle design 
without having to re-run a new bulk build if there was just one puzzle design that you didn’t like. 

File Naming 
“Bulk Builder” will name each file with a number for the design, followed by a letter for the variation.  
Given the example above with ten designs and three variations, you will get exported files named: 

MyPuzzle-1a, MyPuzzle-1b, MyPuzzle-1c, 

MyPuzzle-2a, MyPuzzle-2b, and MyPuzzle-2c, … up to: 

MyPuzzle-10a, MyPuzzle-10b, and MyPuzzle-10c. 
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Preparing a Puzzle for Bulk Building 
Before starting a “Bulk Builder” session, you must first set up a Whirlwind WordSearch document with 
the basic settings you want to use for the puzzles in this bulk run.  This document will be your “starting 
template.” The puzzles created during this run will each start out with the layout you have set up in this 
document.  Then Bulk Builder will use your settings to change certain settings of each created puzzle.  
You do not need to save this “template” document to a file or even build a puzzle from it. However, you 
may want to initially build a puzzle with it in order to preview how it looks before commiting to the bulk 
build. You can optionally save this document so you can easily load it back up later to re-run the bulk 
process. 

Note: If you do not want “random” changes to settings, but instead want several groups of puzzles 
sharing the same settings (for example, 20 easy puzzles, 20 medium puzzles, and 20 difficult puzzles) 
then you can combine the Bulk-Builder feature with the “Multiple Template Documents” idea 
described in this linked section. 

To prepare, first open a new document and choose the basic settings you want to use for this group of 
puzzles.  Every bulk-built puzzle will start with these settings. 

Now you are ready to configure the settings for the bulk run.  Choose “Bulk Builder” from the action 
menu and open it.  The settings are separated and grouped under four main tabs. 
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How Many 
This tab lets you choose how many puzzle designs and variations to create in this bulk run. 

Number of Designs To Build 
Choose the number of unique puzzle “designs” you want to bulk-build.  When you start the run, it will 
load the next set of words. The settings that you choose below for each puzzle design will randomly 
change as it builds each puzzle. It saves the corresponding puzzle file (and an answer & info file) for each 
design it builds.  Each puzzle design will be numbered, 1,2,3, etc. 

Number of Variations of Each Design To Build: 
Normally you may only want one puzzle built for each design.  But there may be times when you want to 
choose the best from several variations of each puzzle design.  Let’s say you want to build forty-two 
puzzles, but you know that you don’t always like the particular randomized word layout of any given 
word search puzzle. Therefore, you want a few extra variations of that puzzle design.  You can do this by 
choosing to create more than one variation for a design. 

If you choose five variations, then the bulk operation will build forty-two puzzle designs. For each design 
it sets up, it will build and save five different word search puzzles with that design.  In all, a total of 210 
word searches will be created. Each of the puzzle design files will be numbered 1,2,3…42, but they will 
now also have the five variations added to their filenames as a, b ,c, d, and e.  So the files will be named: 
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MyPuzzle_1a, MyPuzzle_1b, MyPuzzle_1c, MyPuzzle_1d, and MyPuzzle_1e. 

MyPuzzle_2a, MyPuzzle_2b, MyPuzzle_2c, MyPuzzle_2d, and MyPuzzle_2e. 

When the bulk build is complete, you can then choose your best variation (a-e) for each of these forty-two 
word search designs. 

Continue Building if Errors Occur 
Normally, if there is a problem building or writing a puzzle's file during this long run, immediately stop 
running the bulk builder. Then, you can fix the problem and restart it.  However, if you want it to ignore 
an error of one puzzle and just charge ahead making the rest of the puzzles, you can turn this checkbox on.  
Any puzzle that cannot be built will instead write an error text file with information about the puzzle and 
why it had a problem.  This may be useful if you are trying to build many puzzles with secret messages, 
where sometimes the message doesn’t fit the particular randomly chosen puzzle size/shape. In this case, 
you want to ignore the problem and keep building the other puzzle designs. 

Settings Randomizer 
This tab lets you select a number of settings in your document. This will randomly change settings of each 
puzzle design that is built.  If you leave a checkbox off here, it will use the setting from your underlying 
puzzle document for all the puzzles you generate in the bulk session. 

Settings Randomizer: Sizes 
To use Sizes, leave the “Choose…” checkbox off. Create all the puzzles using the underlying document 
size setting you have.  Or, you can turn on randomness. It will randomly pick any puzzle sizes within the 
size range you have chosen.  If you set the lower range to something below ten (the smallest size that 
allows shapes), then any puzzles that are randomly created below the size of ten will default to a square 
shape, no matter what you set for puzzle shape. 
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Settings Randomizer: Shapes 
You can turn on any number of the pre-defined 
geometric or alpha-numeric shapes and build 
puzzles.  Whirlwind Wordsearch will choose a 
different shape from your list for each puzzle 
design it creates.  If you have asked to build 
more puzzles than chosen shapes, then after 
Whirlwind Wordsearch uses all your shapes 
once, it will re-fill the shapes and start choosing 
from your list of shapes again. 

You can bulk-build puzzles from your user-
designed shape instead.  Simply choose your 
user-designed shape in the document under the “Layout:Size/Shape:Puzzle Shape” tab. Then, turn off 
“Choose random puzzle shapes” in the “Bulk Builder” window.  Your user-designed shape will be used 
for all bulk puzzle designs. 

Settings Randomizer: Difficulty 
For the “Difficulty” randomizer, you can leave the 
“Choose…” checkbox off. It will create all your puzzles 
using the same setting from the underlying document.  
Or, you can turn this on. In turn, it will randomly pick 
any puzzle difficulties within the range you choose for 
each puzzle design. 

Bulk Word Lists 
This tab lets you type in large lists of words and other useful commands to help guide the automatic 
puzzle-building process. 

Bulk Builder will read and use this corresponding list of words for each puzzle design it builds. You can 
either type the text here, or copy/paste it in from another document.  These text lines are automatically 
saved and remembered between bulk builds inside your current Whirlwind WordSearch document. 
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Tap the circle “help” button near the top of this tab area to open and view a document that fully explains 
the format of the Bulk Builder word lists and commands that can be entered here.  The document will go 
into detail on how you can format this text, and what features are available. 

Note: You can also access this extra guide anytime by choosing “Bulk Builder Guide” from the Help 
menu. 
Tip: If you want to automatically add the current puzzle design counter into your title (e.g. “Easy 
Puzzles - #1”, “Easy Puzzles - #2”,) you add the magic “puzzle macro string” $$designcounter into 
your Bulk Word list #title command, and it will get automatically filled in for you as you bulk-build the 
files.  See the “Puzzle Macros” section for more information. 

Once you have entered your word list and commands, tap the “Load and Check” button to have the bulk 
builder load the words and commands. Ensure you entered everything error-free.  If the lines loaded 
alright, then you will see a green dot after the “Load and Check” button.  If there was a problem, then 
there will be a red dot and an error message next to it, explaining what went wrong. 

If you are building a word list group, you have the option of building your puzzles in the same order as 
you entered your groups (group #1 is used for puzzle #1, group #2 for puzzle #2, etc.), or you can shuffle 
the groups so each puzzle will choose one of your groups at random, using a different group each time.  
Use the checkbox titled “Shuffle the build order of your word list groups” to change it. 

Note: This list of words is completely separate from the single word list in your main document.  If 
you wish to start using the single word list from your document here as well, simply close this bulk 
window. Switch to the Words:Word List: tab. Copy the entire word list from that text box.  Then, re-
open this bulk build window and switch to this “Bulk Word Lists” tab. Paste in the word list to this text 
box.  The word lists will be in these two separate spots.  You can add to this bulk word list without 
affecting the main document’s word list. 

____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs47 102

http://www.schwansongs.com


Export To 
This tab is almost the same as the regular “Export” dialog. (To learn more about exporting, see the Export 
section linked here.) Although similar, this tab area is used by the bulk builder instead. 

The only difference here is that the “Add Export Counter” setting is always on for bulk runs. So, that each 
exported word search will be uniquely numbered.  It lets you choose various settings related to the 
destination files that are exported for each puzzle. For example, it lets you choose what file format to use, 
what the filenames should look like, and to what directory to write them. 

One Button to Build Them All 
Finally, tap the Start button. The puzzles will be built and exported one by one, along with their puzzle 
and answer files. Their files will all be saved to the export directory you chose.  If your puzzle dimensions 
are large, this can take several minutes to build a lot of large puzzles. 

As it builds each puzzle, the preview area will display the current puzzle it is working on.  There is also a 
visual indication of completion via an upper progress bar for the entire build job. A lower progress bar 
shows progress for each puzzle being built.  It will also attempt to refresh the preview area behind the 
bulk window as each puzzle is built. 
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If you want to stop the build process partway through, simply tap the stop button. It will stop building 
puzzles.  It will cleanly stop, and any existing puzzle files that it has already built will remain in the 
directory.  When you start the bulk-build process again, it will restart from the beginning, and attempt to 
overwrite any prior files. 

Once you have all the bulk settings arranged the way you like, you may want to tap the Save Settings as 
Default button to save all the current settings into your document.  That way, all future new puzzles you 
create will start off with these bulk settings. 

Bulk Building - Additional Notes 
If you have a regular “Secret Message” set in your document, then “Bulk Build” will add that same secret 
message text to each puzzle. That is, unless you have loaded some “secret message” commands in the 
“Bulk Word Lists” text. 

Note: As mentioned above, if a puzzle cannot be built, then an error text file will be exported in its 
place, with its filename containing an …_Err.txt” ending. 

If you are making secret messages and also specified the positioning of “Exact Fit” - or turned on bulk 
random puzzles sizes - then it is possible that, during the bulk operation, it will design a puzzle that cannot 
place the secret message successfully and it will fail.  If you want it to ignore these and continue, thereby 
getting as many good puzzles as you can, simply turn on the “Continue Building if Errors Occur” 
checkbox, located beneath the “How Many” tab.  It will try creating each secret message design with as 
many variations as you have set it to. 

If you plan on doing multiple bulk-build runs, you may want to do some initial preparation to streamline 
your workflow. This can be done by choosing where the exported files get written.  For example, you may 
want to either (1) have all your bulk projects go to a single directory, or (2) you may want to have each 
bulk project go to its own separate directory.  For more instructions on how to set up either of these two 
workflow styles, please read the following two sections below. 
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4.31. Save Default Bulk-Builder Settings for All Future New Puzzles (Pro 
Feature) 

The Pro version of this software allows you to automatically generate a large number of puzzles all at 
once.  If you want most of the bulk puzzle settings to be identical when you use the bulk feature, then here 
is what you do. 

First, open a new puzzle document. Set it up with all the settings you want to use.  Then, open the Bulk 
Builder window and update each of its tabbed settings the way you want them to appear.  Make sure to 
choose the export tab. Then, choose an export format, size, and destination directory. 

Now tap the “Save Settings as Default” button at the bottom of the bulk window.  Then choose “Save 
Current Settings as Default" from the Whirlwind WordSearch Pro main menu.  From now on, all your new 
documents will be created with all the bulk settings just as you set them here. 

You can make changes to this saved “default set”: Open a new puzzle document; Open the Bulk Builder 
window; Update any settings you want; Choose “Save Current Settings as Default" from the Whirlwind 
WordSearch Pro main menu again. 

4.32. Save Different Bulk Settings for Each Bulk Run (Pro Feature) 
The Pro version of this software allows you to automatically generate a large number of puzzles all at 
once.  However, you may want to set up different bulk settings for different projects.  For example, you 
may have five “beginner” books to make, and five “advanced” books to make.  You want to set up a 
“beginner” bulk setting for those first five books, and a separate “advanced” setting for the other five 
books.  Here is how you can do this. 

First, open a new puzzle window, setting it up with all the settings you want to start with for the 
“beginner” books.  Then open the bulk window. Continue to update each of the tabbed bulk settings the 
way you want for those “beginner” books.  Choose the export tab; then, choose a format, size, and 
destination directory. 

Next, save all these settings in this “beginner” puzzle document.  Tap “Close” on the bulk window. Then, 
choose “Save…” from Whirlwind Wordsearch’s File menu and type in a name for this beginner 
“template” puzzle document.  For example, you may want to call it “Template-Beginner.”  You may also 
want to create a “Puzzle Templates” directory to save all these template files together.  Note that this is 
simply a regular Whirlwind WordSearch document containing all your saved puzzle and bulk settings 
within it. 

Now do all the same steps above to create an “advanced” settings template document. Although, change 
the puzzle and bulk settings to these new “advanced” settings before saving it. 

Now you have two saved Whirlwind Wordsearch documents, each with its own saved settings. You can 
open these at any time and start a bulk build to create all the puzzles for that template. 

You are now ready to start building!  To work on one bulk-build run with all its settings in place, simply 
open the appropriate “settings template document” you made earlier. Then, open the bulk window and 
start the bulk run. 
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When the bulk run completes, you can open a different template document . Open its bulk window, and 4

start its bulk run. It will use its own settings to build the puzzles. 

Upon completing the bulk operations, you can close the template windows. 

Important: Running a bulk operation on an opened document will automatically update a lot of the 
document’s settings. Overall it changes the document’s shape, size, difficulty, and answer layout for 
each puzzle.  If you want to keep your underlying document settings as they originally were, then when 
the bulk build is complete, make sure to close these documents without saving any changes. 

 Although you can open two windows and run two bulk operations at the same time, I don’t recommend running 4

more than one or two at a time. Each running bulk operation gives your computer quite a workout.
____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs51 102

http://www.schwansongs.com


4.33. Use Puzzle-Macros in Text (Full & Pro Feature) 
You might want to have the title, subtitle, or secret message text of your puzzle automatically update with 
information about the puzzle, a puzzle counter, or the current date, without you updating it each time.  For 
example if you create monthly puzzles, you might want to show the name of the current month and the 
name of the puzzle shape in the title.  You can do this by adding a specially formatted puzzle-macro  in 5

the text field, and when the puzzle is created and printed or exported, the puzzle-macro will be replaced 
with the actual text it refers to. 

Here is an example of a few puzzles with their subtitles automatically updated for each puzzle. 

You can achieve this by adding the puzzle-macros $$shape and $$dimxy into the text where you want the 
shape and size to show.  Then, when each puzzle is created, the puzzle-macros will be replaced by their 
current real value in-place.  The Preview area will immediately display the filled-in title and subtitle as 
you type them.  To get the subtitle results shown above, you would type your title and subtitle like this: 

The text fields that accept puzzle-macros are the Title, Subtitle, and Secret Message text fields. 

 In other software applications these are sometimes also called “parameters” or”variables” or “placeholders”.5
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Puzzle-macros must start with $$ and must be all lower-case.  If you misspell a puzzle-macro, then it will 
be displayed unchanged, just as you typed it.  After you complete the typing of a puzzle-macro in a text 
field, it will automatically be shown (in its expanded form) in the Preview area.  The list of each puzzle-
macro along with its description is below: 

• $$shape - This will insert the name of the shape for this puzzle (from the shape menu.)

• $$dimension - This will insert the number of letters wide for this puzzle, e.g., “16”.  This will always 

be a single Arabic number.

• $$language - This will insert the displayable name of the Alphabet/Numbers you choose for this 

puzzle (or if using Bulk Builder, it will come from the #language command for the current puzzle.)

• $$dimxy - This will insert the number of letters wide and tall for this puzzle, e.g. “16x16”. These will 

always be Arabic numbers.

• $$numwordlistwords - This will insert a count of the number of words displayed in the puzzle's 

word list.  This is the final number of words the user expects to find in the puzzle, so it does not 
count hidden or dropped optional words.


• $$numhiddenwords - This will insert a count of the number of hidden words (including any of your 
extra hidden words).


• $$exportcounter - This will insert the current “Export counter”, which will begin numbering with the 
“Export Counter starting” value you choose in the Export dialog, and will increase with each puzzle 
you export.  This can be used to add a “puzzle #” in your puzzle titles, which will correspond with 
the number in the exported file names of each puzzle.  For more information on using the Export 
Counter, see this section link.


• $$datetoday - This will insert today’s date (year, month, day), based upon your local country’s 
region setting on your computer.


• $$thisyear - This will insert the current 4-digit year, formatted according to your computer’s locale 
setting.


• $$thismonth - This will insert the full name of the current month, formatted according to your 
computer’s locale setting.


• $$thisweekday - This will insert the name of this day of the week, formatted according to your 
computer’s locale setting.


• $$nextmonth - This will insert the full name of the month following this month, formatted according 
to your computer’s locale setting.  This could be useful if you always make a maze ahead of time to 
publish the following month.


• $$nextweekday - This will insert the full name of the day of the week for tomorrow, formatted 
according to your computer’s locale setting.  This could be useful if you always make a maze ahead 
of time to publish the following day.


The following puzzle-macros are available in Whirlwind WordSearch Pro for the #title, #subtitle, and 
#secretmsg commands, when you use the Bulk-Builder feature:

• $$designcounter - This will insert the current Bulk-Builder design counter, as a value starting at 1 

and increasing for each puzzle design to the total number of puzzle designs you wanted to create.  
This is the overall bulk-created puzzle number.
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• $$variationcounter - This will insert the current Bulk-Builder design variation counter, as a letter 
value starting at 'a' and increasing for each variation of the current puzzle design.  If you choose not 
to have any variations (by setting “number of variations…” to 1), then this puzzle-macro will be 
empty.
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4.34. Upgrade to Get the Pro Features 
Run Whirlwind WordSearch, and find the “Whirlwind WordSearch” application menu at the top left of 
your screen. Open the menu and select “Pro Upgrade…”.  This menu item lets you immediately get all the 
extra features available in the Professional (Pro) version of this software via a one-time in-app purchase. 

Simply tap the button “Upgrade for $—” 
to begin the upgrade.  If you have 
already purchased the Pro upgrade on a 
different computer and don’t yet have the 
upgrade license on this computer, you 
can easily use this dialog to “restore” 
your Pro purchase onto this computer as 
well.  In that case, simply tap the 
“Restore Purchase” button instead.  Once 
you have upgraded to Pro, you will be 
able to receive all future Pro updates. 
You will also receive  new full and pro 
features for free, forever. 

You will be asked to log into the Apple App Store with your Apple 
ID, which you used to purchase software. Then, you will be able to 
upgrade or restore it. 

After upgrading, you will need to quit 
and re-start the software. This allow 
Whirlwind Wordsearch to start up with 
the Pro features. 

After that, all the Pro features available 
will be available to you (bigger puzzles, 
bulk-builder, user-designed shapes, 
alpha-numeric shapes, more export 
styles, etc.) 
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4.35. Get a Commercial License to Sell Puzzles in your Own Books and 
Products 

You do not need any commercial license to sell any of your puzzles created with my software! All 
exported puzzles and answers are copyright-free and royalty-free without any requirement for you to 
obtain a commercial-use license.  You are explicitly allowed to give away or sell all the puzzles you create 
with my software.  Moreover, you can use the exported information to generate your own games from 
them. I do not require you to fill out any kind of license, ever!  Of course, if you still want to offer me 
something, please see the next item below. 

4.36. Add Whirlwind WordSearch Software Credits to your Own Product 
You do not need to credit my software in your own publications or software that use the puzzles.  At the 
same time, I would certainly appreciate it if you do mention it.  After all, doing so will help advertise my 
own products, which allows me to work on even more features and other software products for you.  Win 
win! 

Many people like to read honest reviews about products before getting them. So, I would encourage you 
to write and publish a review of my software on Apple’s App store, in your own blog/newsletter, or on 
your YouTube channel.  Here is a suggestion for a “credits line” that you could add somewhere in your 
newsletter, book, or web/software product: 
These puzzles were designed with Whirlwind WordSearch by SchwanSongs: www.schwansongs.com 

You may also want to visit the main Whirlwind WordSearch product web page here: 
http://www.schwansongs.com/whirlwind/#PressKit 

and download a free copy of the Press Kit, which includes text and graphics you might want to use in your 
review. 

4.37. Print This User Guide to a Printer 
Here is how you would print a copy of this user guide, instead of viewing it on-screen. 

First, open the user guide window by choosing “Whirlwind WordSearch * User Guide” from the “Help” 
menu.  With the user guide window displaying, choose“Print” from the “File” menu.  It will print the 
entire user guide to your printer. 

You can also download the full PDF file of this file directly from the button at the top of the user guide 
window, or from the software product page of my web site.  Then, you can easily read it elsewhere 
“offline.” 
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4.38. Find the Hidden “Easter Egg” Features 
Why do you think there are extra features hidden in my software?  
Who told you?  I have absolutely no idea what you are talking about.  I 
don’t believe  there are magic words that let you unlock extra features.  6

Of course, if they did exist, I am sure you would be alerted by some 
kind of “Bat-signal" at the top of the window. 

OK, one little secret will out.  To print or export a puzzle grid that has not been built yet, simply hold 
down the <Option> key and open the File menu.  This will force the Print and Export menu items to be 
allowed even if there is no puzzle built yet.  You can now create “template” images that are not yet filled 
with letters.  Perhaps useful for creating templates or playing boards for other purposes.  This was 
requested long ago by a user who wanted a template to write in their own word search puzzles. 

4.39. Contact the Author with a Bug Report or Feature Idea 
If you have found something that isn’t working correctly, or if you wish that this software did something 
differently, or you would like a new feature added, I would certainly like to know your thoughts.  I am 
constantly adding these to my to-do list from my users and testers. Likewise, I always strive to update my 
software so that it does what you want it to do.  You can even write just to let me know that it is working 
well and you are enjoying it! 

The best way to contact me is to run the software and choose “Contact Author” from the Help menu.  This 
will open your e-mail software and automatically create an e-mail to me.  This also adds the name and 
version of the software you are currently using at the bottom of the e-mail, which can be helpful to me 
when answering your questions. 

Send any feedback or correspondence to me at: note@schwansongs.com, or via the “Contact” link 
on my web site at: www.schwansongs.com. 

 Yes, there is a subtle but critically important difference between belief and knowledge.6
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5. Details: What does this thing do? 
This section offers more detailed descriptions of each tabs and their individual options.  You can also 
hover your mouse over different options and menus to activate a “tool-tip” text box that will give you 
additional information about each item. 

Note: Some of the features described here are only available in the Full or Pro version, not the Lite 
version. 

5.1. Main Document Window 
When you start Whirlwind WordSearch, it opens a new “document window.”  Configure puzzles by using 
“Control Tab Settings” located on the left-hand side, while looking to the right-side for the “Puzzle 
Preview” area.  The preview displays the updated puzzle as you design it.  Some “Action” buttons along 
the bottom allow quick access to building, printing, or exporting a puzzle. 

This new window can be saved as a document (e.g. file) on your computer. Later, it can be opened (just as 
you do with word processor documents) to show the puzzle and all its settings, saved just as you left them. 

Whirlwind WordSearch allows you to create and open multiple windows at once; although, you will likely 
just open and work with one at a time. 
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5.2. Control Tab Settings on the Left 
You can use many settings to customize and create unique looking puzzles.  They are grouped into sets of 
“tabs” along the upper left side of the document window.  First, there are the “main” tabs along the top. 
When you choose one of those top tabs, there are often additional secondary tabs underneath.  All of these 
tab-grouped settings are described below. 

5.3. Layout:Title - Tab 
The “Title” tab is where you choose the title and subtitle to print above your puzzle. It appears on the 
printed pages, and optionally on the exported puzzle files.  These fields are optional and can be left blank 
if you want no title text displayed. 

Title/Subtitle: You can enter text in the title field and/or subtitle field, and that text is then printed at the 
top of your printed puzzle pages.  You can also leave either or both fields blank, since they are optional.  
The title field is printed in a slightly larger font size, while the subtitle is a little smaller. This allows more 
text on the subtitle line.  If you type in title or subtitle text that is too long, the text will wrap to a second 
line at the edge of the page when it is printed. 

Tip: If you want a lot of title text but no subtitle, you can leave the title string blank and use the subtitle 
string for your text. This gives you more room for more text, since the subtitle is a smaller font.  You 
can allow even more text by shrinking the “Title font size adjustment” slider. 
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Note: If you want to refer to the current date or the current puzzle number or puzzle shape/size in your 
title, e.g. “Heart Puzzle #3 for Monday”, you can add magic “puzzle macro strings” in the title and 
subtitle fields, and they will get automatically filled in for you as you print or export.  See the “Puzzle 
Macros” section for more information. 

Title Font: You can print the title and subtitle text using any font that is installed on your computer.  
Please note that not every font can display alphabetic letters in languages other than English, so you may 
need to experiment to see which ones work and look best for your purposes.  

Title Color: Tap the color wheel to choose a new color to use for the titles and the word list.  Note that 
the color of the letters within the puzzle grid are set separately.  See the layout tab below. 

Title Justification: You can choose left, centered, or right justification for your title/subtitle. 

Title font size adjustment: Fine-tune the size of the printed title and subtitle text.  Sliding it down to the 
left will make the text grow smaller, while sliding it to the right of center will make it grow larger.  An 
approximate display of how the text will print is shown above the puzzle in the preview area. 

Note: The “font size adjustment” is not available in the Lite version of this software. 
As an example, if you typed the following in the title and subtitle fields: 

The top of the printed page would look like this: 

Show on exported Answer files too: Normally the titles are only shown on the Puzzle files when the 
puzzle and answer are exported.  Turn this on to show them on the exported Answer files too.  This will 
affect regular exports as well as bulk-build exports. 
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5.4. Layout:Size/Shape - Tab 
This tab lets you adjust the overall size of the puzzle. It determines how many letter cells go across and 
down. Likewise, it lets you instantly choose from a number of additional built-in shapes. 

Puzzle Size 
This sets the total size (number of letters available) for the puzzle.  The puzzle size must be at least as 
large as the number of letters in your longest word. Otherwise, a word that is any longer than the puzzle 
size would never fit.  Whirlwind WordSearch will allow you to type in words that are longer than your 
puzzle size.  It is not until you entered all your words and tap the build button, however, that it double-
checks whether your longest words will fit.  If a word is still too long for the current puzzle size, then it 
will it give you an error dialog. At this point, it will tell you what the problem is and how to fix it. 

Remember, the bigger the puzzle size, the more letter spaces are available. Therefore the more words can 
fit into the puzzle.  Also, as you increase puzzle’s size, the overall font size of the letters in the printed 
puzzle and answer grid will automatically shrink. This makes it possible to fit the entire puzzle onto a 
single printed page. 

Short Side Size 
This slider appears when you choose a shape of either “rectangle tall” or “rectangle wide”. It lets you 
choose the short(er) side size, i.e., the number of cells along the shorter side of the rectangle. The larger 
the number, the closer to a square it becomes. Changing this allows you to fine-tune your rectangle puzzle 
to fit either a tall, thin column or a wide, thin row. 

____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs61 102

http://www.schwansongs.com


Note: Unlike other shapes, once you choose one of the Rectangle shapes you can now make the 
“Puzzle Size” smaller than ten, in case you want to make 5x9 rectangular puzzles, for example. 

Puzzle Shape 
You can choose from many different shapes to use.  However, the shapes only become available if you 
have a puzzle size that is ten or bigger. Any puzzles smaller than this must be square. 

Geometric Shape: This lets you choose from a variety of preset shapes for the puzzle.  Here are the 
available geometric shapes: 

Alpha-Numeric Shape: (Pro Feature) This lets you choose from the uppercase letters A through Z, and 
the numeric digits zero through nine. 

Font: (Pro Feature) You can choose from a variety of fonts to shape the alpha-numeric characters. 

Design your Shape: (Pro Feature) This lets you design your own shapes.  A built-in “shape editor” 
allows you to design a logo or complex shape of your own. You can then use that to create your puzzle.  
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You can also export your shape to send to others, or import shapes designed by other software users.      
See the “Design your own shape” section linked here. 

Note: When you choose one of these non-square shapes, there are not as many available letter spaces in 
the puzzle.  If you have long words or a lot of words, they may not all fit in these other shapes.  To 
compensate for this and still fit in your words, you will need to increase the puzzle dimension.  
Furthermore, many of these shapes will look nicer & smoother at larger puzzle sizes. 

5.5. Layout:Letters - Tab 
This tab lets you adjust the look of the letters inside the puzzle grid. 

Letter Font: You can display the puzzle letters using any font that is installed on your computer.  Please 
note, though, that not every font can display alphabetic letters in languages other than English. Therefore, 
you may need to experiment to see which ones work and look best for your purposes.  As you switch 
fonts, the puzzle grid will immediately re-display in this new font.  

Letter Color: Tap the color wheel to pick a new color for the puzzle and answer letters inside the puzzle 
grid. 

Draw Letter Outlines in color: Turn this on to draw the puzzle letters with an outline (or “stroke”) color.  
When this is on, you can choose the outline color, and adjust the “Outline Thickness”. 

Note: If you turn this on, set the outline color to black, and set the Letter Color to white, you can create 
letters that the user can “color in” as they solve the puzzle. 

Outline Thickness: This adjusts the relative width of the outline drawn around each letter, from 1 (very 
thin) to 5 (very thick.) 
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Print Letters in Lowercase: Turn this on to print the letters of the puzzle and answer key in lowercase, 
instead of uppercase.  You may want to turn this OFF for younger puzzle solvers. 

Remove All Diacriticals from Letters: Turn this on to strip any diacritical marks from your words when 
they are added to the puzzle grid.  When your words are displayed in the word list, the diacriticals are 
always left in place.  This “simplified” puzzle display is commonly used in some languages, e.g. Italian.  
Leaving this off will leave any diacriticals in the letters of  your words when placed in the puzzle grid.  To 
add/remove any diacriticals in the fill letters around your words, see the related topic: “Your fill Letter 
Subset to Use” under the “Advanced Difficulty” section linked here. 

Vertical Letter Font Adjustment: This feature lets you fine-tune the letters’ vertical position in the 
puzzle/answer grid.  Sliding it down to the left will slide the letters below center, and sliding it right will 
slide them above center.  This can be useful if you have an unusual font that doesn't display quite centered 
vertically. In this case, you need to nudge the letters up or down a bit inside the grid. 

Relative (Automatic) Font Size: This is the normal automatic-letter-sizing behavior. It will either grow 
or shrink the letters within the puzzle grid when printing or exporting your puzzle.  That is, the letter sizes 
will look the same on the printed or exported output as they are shown in the preview window. 

Relative Font Size Adjustment: This slider lets you fine-tune the size of the letters in the puzzle/answer 
grid.  The basic font size is automatically calculated for you based on some factors (size of puzzle, and the 
size of the printed page). Though, you may find this calculated size “not quite right” for your needs.  
Perhaps the font that you chose is a little larger or smaller than other fonts and doesn’t fit quite right.  The 
slider's value at 1.0 is the regular size.  Sliding it to the left will make the letters grow smaller, and sliding 
it to the right will make them grow larger. 

Fixed (Specific) Font Size: Not many people will need this option turned on.  For advanced users, this 
will force the letter font to be printed at your specified point size, no matter how big or small the puzzle 
page size is. This overrides the normal behavior where the letter font size automatically shrinks as the 
puzzle size grows.  When you are exporting puzzles with this setting on, the puzzle letter font will not 
match the “relative” size you see in the preview window. As a result, you will see differences in letter 
sizes between PDF and PNG file formats.  As a PDF-export workaround, you can save a PDF file (that 
matches the preview) via the print dialog, by following the section here.  Describing interactions and 
calculations of font point size, document size, DPI, and PDF font handling is beyond the scope of this 
document. 
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5.6. Layout:Word List - Tab 
This tab lets you adjust how the word list is formatted and displayed on the puzzle and answer pages.  
These options will affect the printed pages, and the export images if you include the word list during 
export.  You can also choose whether to have the word list shown on the puzzle or answer page, or both 
(or none.) 

What to Display in the Word List: Here you can choose how the word list is displayed under your 
puzzle when you print or export it. This also sets how it is formatted if you copy it to the clipboard via the 
menu item “Edit:Copy Formatted:Word list…” 

The word list can be a single comma-separated, word-wrapped line of words. This might be best for 
puzzles with lots of long words or if the word list is printed with a large font size. 

The word list can have each word separated, one-word-per-line, into multiple columns.  You can center 
the words within each column, or  you may want to add numbers to each word. 

If you are using the word clues feature, you can show just the word clues instead of the words on the 
puzzle page.  For more information on the “word clues” feature, see this section link. 

Include Direction Arrows: You may want to add a little 
direction arrow beside each word on the answer key to 
help find the words in a large puzzle.  You may even want 
to add these arrows on the puzzle itself, as helpful hints 
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for beginners.  To show the arrows on the puzzle too, simply turn off the checkbox “only on Answer key.” 

Number of columns: Leave this as “Auto-Calculated” to let Whirlwind WordSearch find the best row and 
column fit for the word list at the given font size.  If you would prefer to force a particular number of 
columns for the exported/printed output, you can set this to any number from 1 to 8, and it will try to fit 
all the words into that many columns instead.  This control is not available when the “Print word list as:” 
popup is set to “Words with commas.” 

Word list font: You can choose any font to display the word list.  Usually, it’s best to have it be the same 
font that is used for the puzzle letters themselves. You can immediately use that same puzzle letter font by 
tapping the Match Letter Font button next to it. 

Word list color: You can choose any color to display the word list.  It is usually best to have it be the 
same color that is used for the puzzle letters themselves. You can immediately use that same puzzle letter 
color by tapping the Match Letter Color button next to it. 

Center the words: Turn this on to center the words in their columns.  Turn this off to leave them left-
justified in their columns.  You will usually leave this off if you add numbering to the words.  This will 
also center the word list lines if “Print word list as” is set to “comma-separated.” 

Add numbering to word list: Turn this on to add numbering (1,2,3,…) before each word in the printed 
word list.  If this is off, the words will be listed without any numbering. 

Alphabetize the printed word list: Turn this on to print the list of words sorted in alphabetical order.  If 
this is off, the words will be listed in the order you entered them in your “word list." 

Print word list as all uppercase: Turn this on to fully capitalize the list of words when they are printed.  
If this is off, the words will remain capitalized as you entered them in the “word list."  This option will be 
disabled if you have chosen an alphabet that does not have upper/lower case. 

Word list font size: You can fine-tune the size of the printed word list words here.  The font size is 
automatically chosen for you based on several factors (number of words, length of words, or the puzzle’s 
size), but you may find this calculated size is “not quite right” for your needs.  Maybe there is one really 
long word that stretches into the word in the next column and you need to shrink the size a bit.  Maybe 
there are lots of short words, and you want to bump the size up for younger or older readers. 

The center position is regular size.  Sliding it to the left will make the words grow smaller, while sliding it 
to the right of center will make them grow larger.  The font size of any secret message printed under the 
puzzle will also gently track this size change. 

Left indent: This will add a left-edge indent to the word list. It can be from 0% (against the left edge of 
the puzzle) up to 30% of the width of the word list area. 

Top margin: This will move the word list down away from the puzzle above it. It can be from 0% (very 
close to the bottom of the puzzle) up to 10% of the height of your cousin, because it is relative. 

Show the word list: Choose whether to show the word list on the Puzzle page, the Answer page or both 
or none.  This affects both Printing and Export. 
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5.7. Layout:Grid - Tab 
This tab lets you add lines around the letters and puzzle, while also setting the thickness and color of the 
lines. 

Grid Line Size: Tap the pop-up menu to choose a new line thickness (in points) for the separator (grid) 
lines around each letter on the puzzle.  If you choose “none,” it will draw no grid lines around the puzzle.  
Note that it will always draw grid lines around the answer key, since they help show you where the 
answer words are in the puzzle.  0.5 is a very thin line, and 8.0 is a very thick line. 

Grid Line Color: Tap the color wheel to pick a new color for the puzzle and answer “grid lines." 

Draw Only Puzzle Shape Outline: Turn this on to draw just the outline around the shape, without inner 
grid lines around letters.  Turn it off to draw grid lines around every letter in the shape. 

Add Cell Fill Color: Turn this on to fill each cell square with an opaque background color for printing and 
for exported image files.  If it is on, you can tap the color wheel to pick a new color for the cell-fill color.  
If this is off, the cells are transparent. Any background will show up behind the letters. 
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5.8. Layout:SPIN - Tab 
Each Specific Puzzle Identification Number, or SPIN, specifies a unique placement of the words in the 
current puzzle. It can be used to 
exactly re-create a particular word 
layout for a puzzle.  Think of it as a 
serial number for the puzzle and its 
answer.  Normally you will leave 
this off (unlocked) and let the 
software generate its own new 
random SPIN (i.e., new puzzle 
configuration) each time you tap the 
“Build” button. 

The SPIN can be any positive 
number from one to sixteen digits 
long. 

Lock Down This SPIN: If you prefer a particular layout for the answer, you can “Lock" the puzzle. 
Therefore, the current value for the puzzle is unchanged.  It keeps the puzzle answer the same if you 
rebuild it. The SPIN is used for both a puzzle and its answer. When you print the SPIN on various puzzle 
and answer pages, you can easily use the SPIN to match which puzzle goes with which answer. 

Also, when you lock the SPIN, it allows you to type in your own SPIN as another option.  That way, you 
can re-create a prior puzzle layout. 

Upon turning this option on, a small warning will display at the top right 
corner of the document window. It reminds you that your puzzle 
configuration is now “locked” in a certain configuration. 

5.9. Words - Tab 
This tab lets you choose the alphabetic letters used for your word list.  It is where you enter the list of 
words you want placed into the puzzle.  It also has a tab for optionally embedding a “secret message” in 
your puzzle. 
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5.10. Words:Alphabets/Numbers - Tab 

Choose the Language/Alphabet/Numbers 
This pop-up menu lets you choose a different language (and its alphabet of letters) to use in your puzzle.  
Your word list and secret message must only contain these letters, otherwise you will get an error 
message: 

When you choose a different alphabet, the list of allowed 
letters will change to match your new alphabet.  It also 
switches to a list of “naughty words” for that language, using 
that list to find and remove any randomly created naughty 
words from each puzzle you generate. 

Allow Numbers in Words 
You can turn this checkbox on to let you add Arabic numbers into your words (and secret message.)  This 
would allow you to add words like “Route 66” or “Room 101” to your puzzles. 

And yes, if you choose Japanese Hiragana or Katakana, then the Japanese numeric kanji characters (零一
二三四五六七八九十百千万億兆) are allowed too. 
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5.11. Words:Word List - Tab 
This tab has a text field for you enter the list of words for your puzzle, and also some controls related to 
the words. 

Word List 
Your words must only use the letters available in the alphabet you choose. They can be uppercase, 
lowercase, or mixed case.  Each word must be separated from others by either a comma or a new line.  
Your word's capitalization and word order will be preserved when they are printed as a list on the puzzle 
and answer pages, unless you choose to alphabetize and capitalize them via “Layout:Word List” tabs.  
When the words are placed inside the puzzle grid, though, the case of their letters will all be uppercase, 
unless you chose the “Print Letters in lower case” checkbox under the “Layout:Letters” tabs. 

You can also copy a list of words in from another word processing document or from the internet.  Just 
copy the words from the other application, and then switch to Whirlwind WordSearch. Tap inside the word 
list text box and choose “Paste” from the “Edit” menu. The words will be added to your list.  See this 
section link for detailed instructions on how to do this. 

If you are creating a special word search puzzle that displays a list of “word clue” phrases instead of the 
list of words themselves, you must enter the word and its associated clue phrase together, each 
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“word:word-clue” pair on a separate line.  See this section link for detailed information on making this 
special puzzle style. 

You can also create an unusual twist in the word search game, where you display a number of words in the 
list, but leave one word out of the actual puzzle, and ask people to find which word is “missing.”  You can 
do this by putting a dash (minus sign) before one of the words, and that word will be shown in the word 
list, but will NOT be added to the puzzle.  You can mark multiple words as “missing” too, if you like. 

Whirlwind WordSearch is very lenient, and allows you to initially type or copy/paste any characters into 
the word list box.  However, before you create a word search puzzle, you may need to remove extra 
characters that are not part of your words. Once you tap the “Build" button, Whirlwind WordSearch 
checks that all your words match the alphabet your chose, and will issue an error messages then. 

There are special cases that allow for the space, hyphen/dash (-), and for the apostrophe/single-quote (').  
These characters will be left in the word list display, but removed when the word is put in the puzzle grid.  
For more information on this, see this section link.  

A word search puzzle's size must be at least as large as the letters of your longest word, or else that word 
will never fit in the puzzle.  Whirlwind WordSearch does check all of your words against the puzzle size 
you have chosen, but only after you tap the “Build” button.  This gives you freedom to type long words 
and then change the puzzle size without being interrupted by annoying error messages.  Only when you 
create the puzzle do any problems get detected and reported to you. 

Approx. space remaining: # 
The “Approx. space remaining” number (above the word list) gives you a rough estimate of how many 
letters are left in the current puzzle. This is based on the words you entered and the puzzle's current size 
and shape.  As you add words to your word list, the number shrinks to show you are running out of room 
in the puzzle. It also shrinks as you add text to your secret message, which needs room in the puzzle too.  
This is just an approximate indicator, and does not prevent you from adding many more words than the 
currently-configured puzzle could hold.  For example, it cannot predict how many words might wind up 
overlapping until you finally create the puzzle, or how many words may be automatically removed 
because they are optional.  This looseness allows you to later mark certain words as optional (see this 
section.) 

After you tap the “build” button, Whirlwind WordSearch will attempt to create the puzzle and determine if 
it really can fit all your words in.  If not, it will then give you an error message stating that it cannot place 
all your words.  You can then fix the problem in a number of ways.  Go to the “Layout" tab and increase 
the puzzle size and/or try a different shape that has more space. Alternatively, increase the difficulty level 
(which allows words to overlap and go in additional directions), or remove some words. You might also 
try making some words optional, and then create the puzzle again. 

After you have successfully created a puzzle, the total number of words you entered will be listed under 
your word list.  This is to help you verify that all your words or phrases were entered correctly, and that 
you got the number that you expected. 
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Allow duplicate/mirrored words 
Word search puzzles are usually built from a list of unique words.  However, you may want to create a 
puzzle that has two or more copies of the same word or words in the puzzle. It will also do this if you 
want to enter words that are mirrored (e.g. adding “tool” and “loot.") You can allow this by turning on the 
checkbox “Allow duplicates in word list.” Whirlwind WordSearch will no longer check for duplicate 
words, but instead will add every instance of any word you type. It does this despite however many copies 
there are.  It will further display each copy in the printed word list. 

Make all words “optional” 
Turning on this checkbox will have Whirlwind WordSearch trying to fit as many of your words as it can to 
build a puzzle and remove any that could not fit from your list.  It will only mark your regular words as 
“optional.” That way, any hidden words will always remain in the puzzle. 

You can then get a list of the removed words it could not fit, by tapping the button “Show N removed 
optional words” in the preview area.  See this section link for more details about working with optional 
words. 

Note: The “Make all words optional” feature can only be toggled on/off in the Full version of this 
software.  It is always on in the Lite version. 

Maximum # of optional words to use: 
Turning this on will let you enter a maximum limit to the number of optional words that will be added to 
the puzzle.  This lets you add a word list of dozens or hundreds of words, and enter a maximum value 
here, and each time you build a puzzle it will use no more than that number of words from your list.  It 
will choose a different random subset of your words each time you build the puzzle. 

For example, if you add 100 words into your word list, then turn on “Make all words optional”, turn on 
“Maximum # of optional words to use” and set the value to 20, then all your puzzles will be created with 
no more than 20 of your words. 

Of course it is possible that not even that many words will fit in your puzzle.  In that case it will continue 
to remove more optional words until it can successfully build the puzzle.  This is only a maximum limit of 
words. 
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Allow embedded sub-words in word list 
Turning this on allows words in your word list to appear inside other words in your list, like “beard” and 
“ear”, or “tarp” and “rat.”  Notice that “rat” is mirrored/reversed inside of the word “tarp."  Whirlwind 
WordSearch will be allowed to place “rat” completely inside “tarp.” 

Turn this off to be more strict and detect and flag these “duplicate” embedded words in your word list as 
errors before you build a puzzle. 

Warning: Turning this on can cause reader-confusion with the answer key. Essentially there would now be a 
second “rat” in the puzzle that is not the “rat” in your answer key. The reader could find the “rat” in “tarp,” 
only to find out it is NOT the rat listed in the answer key.  Beware of stray rats. 

Find and remove random "Naughty Words" from puzzle 
Turning this on finds and removes any randomly-generated naughty words from the puzzle. When off, no 
naughty-word-checking happens, which can speed up puzzle-generation, and can sometimes allow trickier 
puzzles to build successfully which might otherwise fail. 

Note: Turning this off can speed up puzzle-generation, and can allow some puzzles to build when they 
would otherwise fail.  For example, if you are building a 40x40 puzzle with a single word, like “Sass”, 
you will find that it builds right away with this setting turned off.  Of course, there will be lots of 
random “ass” words left in the puzzle.  You will have to decide if you want to let your audience deal 
with lots of asses. :-) 

Allow one-letter words 
Normally your words must be two or more letters long.  Sometimes you may want to allow one-letter 
words however. 

Turning this on will allow single-letter words to be entered into your word list.  It additionally 
automatically enable some other settings to support this unusual mode.  Here is what it also turns on at the 
same time: Turns on Advanced Difficulty mode; Turns on “Allow embedded sub-words in word list” and 
sets “Fill Puzzle With:” to fill set and decoys. 

Note: After turning on this setting and having it automatically change some above-mentioned settings, 
you can still manually change back those extra settings.  However, if you do manually change some of 
the extra settings afterward, it will likely cause Whirlwind WordSearch to not be able to successfully 
build your puzzle.  So, change them at your own risk!  After you change them, you can always reset 
back to the suggested “1-letter word” settings by simply turning this checkbox off and then on again… 
Just as you fix most computer things, right? 

Copy formatted word list 
This will copy the word list as a formatted carriage-return. It is a separated list on the clipboard, which 
you can then paste into another document.  The words will be capitalized, sorted and numbered per your 
choices in the "Page Details” tab.  This button is available after you create a puzzle. 
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Random word fill 
This button will replace your current word list with a large list of random words from the dictionary.  The 
length of the words and the number of words will be chosen based on the size of your current puzzle. So, 
a 6x6 puzzle will only choose several words up to six letters long.  The larger the size of the puzzle, the 
more words will be added.  The words are taken from an old built-in dictionary on the Macintosh, and can 
often be a bit, um, obscure. 

Note: This is only available when you have chosen the English language alphabet from the “Alphabets/
Numbers” tab. 
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5.12. Words: Secret Message - Tab (Full & Pro Feature) 

This tab allows you to enter a word, phrase, or sentence. You can  place it into the puzzle after all your 
puzzle words are laid out in place, and before it fills the rest of the puzzle with random letters.  It lays the 
secret message out left-to-right, skipping over any word search letters already laid into the puzzle.  See 
this section link for an example of adding a secret message. 

Enter your secret message text into the text box. Only the alphabetic letters of your typed secret message 
are added into the puzzle.  Any other punctuation or spaces or letters that are not in your current alphabet 
are automatically ignored. 

Copy Secret Message as Template 
Tap this button to copy your Secret Message text to the clipboard, but with all its alphabetic and numeric 
letters replaced with underscores.  This can then be used as a printed “template” or “place-holder” below 
your puzzle, for your users to fill in the letters as they find them.  For example, here is a secret message, 
and below it is the template that would be copied for it: 
Beware the Jabberwock, my son! 

ˍˍˍˍˍˍ ˍˍˍ ˍˍˍˍˍˍˍˍˍˍ, ˍˍ ˍˍˍ! 

Note: You can add an extra space between each underscore by turning on the checkbox “Add Spaces 
Between Template Underscore Letters” described below. 
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Approx. Space Remaining: ## 
This roughly shows how many letters are available for your secret message, based on the words you 
entered and the puzzle's current size and shape.  As you add text to your secret message, this number 
shrinks to show you are running out of room in the puzzle. It also shrinks as you add words in your word 
list, since they need room in the puzzle. 

Show the Secret Message prompt 
Choose whether to show the Secret Message prompt on the Puzzle page, the Answer page or both or none.  
This affects both Printing and Export. 

Position in Puzzle 
You can change where the secret message shows up in the puzzle: at the top, at the bottom, centered in the 
middle, or at a random position. Conversely, you can require it to exactly fill every remaining space in the 
puzzle. 

Highlight the Secret Message Letters in the Answer Key 
Turn this on to print a gray background behind each secret message letter in the printed (or exported) 
answer key.  Turn this off to leave the secret message letters just like any other “non-word” letters in the 
answer. 

Secret Message Prompt 
Puzzle Page: Enter an optional secret message “prefix prompt” to print under the puzzle on the puzzle 
page. This lets the user know that there is a secret message to look out for in the puzzle.  You can leave 
this empty or enter a text hint for your secret message.  The placeholder template will be added after this 
text on the puzzle page. 

Answer Page: Enter an optional secret message “prefix prompt” to print under the answer key on the 
answer page. You can leave this empty or enter a text prompt introducing your secret message.  The 
secret message itself will be added after this text on the answer page. 

Add Spaces Between Template Underscore Letters: Turn this on to add empty space between every 
template underscore letter, thereby helping separate the letter spots.  If this is left off, then the template 
will exactly match the number of letters of your word search’s phrase. The displayed underscores will also 
be “shortened” so they don’t run together like normal underscores.  Note that some fonts do not show 
these “short underscores.” 
Text: Beware the Jabberwock, my son! 

 Off: ˍˍˍˍˍˍ ˍˍˍ ˍˍˍˍˍˍˍˍˍˍ, ˍˍ ˍˍˍ! 

  On: _ _ _ _ _ _   _ _ _   _ _ _ _ _ _ _ _ _ _ ,   _ _   _ _ _ ! 

____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs76 102

http://www.schwansongs.com


5.13. Difficulty - Tab 
The “Difficulty” tab lets you change how tricky the word search puzzles are to solve. 

Using the “Basic Difficulty Mode” lets you simply move a slider from “very easy” puzzles to “very hard” 
puzzles, without worrying about all the details of how it works. 

If you want more control, you can switch to the “Advanced Difficulty Mode.” This lets you control each 
of the fine-grained “difficulty options” yourself.  Both the basic and advanced modes are covered below. 

Basic Difficulty Mode 

Difficulty to Solve: Changing the “Difficulty to Solve” slider will alter several obvious and not-so-
obvious aspects of the generated puzzle.  You can change the puzzle from very easy to solve (for younger 
children) through diabolically difficult to solve (for experienced adults).  Each of the difficulty levels 
creates a puzzle with the following features: 
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1. Very Easy (across): Places words only left-to-right.  The remainder of the puzzle is filled 
with letters of the alphabet that are not in the words (making it much easier to find the words), 
or filled with your optional secret message.  It also ensures that none of your words overlap each 
other.  It allows words to be along the edges and alongside each other.  This easy level is perfect 
for beginning readers. 

2. Very Easy (down): Places words only top-down.  The remainder of the puzzle is filled with 
letters of the alphabet that are not in the words (making it much easier to find the words), or 
filled with your optional secret message. None of your words overlap each other.  It allows 
words to be along the edges and alongside each other.  This easy level is perfect for beginning 
readers, and especially for Japanese language puzzles. 

3. Easy (across & down): Places words left-to-right or top-down.  The remainder of the puzzle 
is filled with any letters of the alphabet, or filled with your optional secret message.  None of 
your words overlap each other.  It allows words to be along the edges and alongside each other. 

4. Medium: Places words left-to-right, top-down, or the two diagonals from left-to-right.  The 
remainder of the puzzle is filled with any letters of the alphabet, or filled with your optional 
secret message.  Some of your words may overlap each other.  It avoids placing words along the 
edges and very top/bottom rows, but allows them to be alongside each other. 

5. Hard: Places words in 6 of the 8 possible directions (4 compass directions and 2 left-to-right 
diagonals.)  The remainder of the puzzle is filled with any letters of the alphabet, or filled with 
your optional secret message. Many of your words may overlap each other.  It avoids placing 
words along the edges and very top/bottom rows, but allows them to be alongside each other. 

6. Harder: Places words in any of the eight possible directions (4 compass directions and 4 
diagonals.)  The remainder of the puzzle is filled with letters of the alphabet that are from your 
words (making it harder to find the words), or filled with your optional secret message. Some of 
your words may overlap each other.  It avoids placing words along the edges and very top/
bottom rows, but allows some to be alongside each other.  It also sprinkles in a few short pieces of words 
from your word list ("decoy wordlets") to throw your puzzle-solvers off the track.  For more information 
on “decoy wordlets,” see the  “Advanced Difficulty Mode” section below. 

7. Very Difficult: Places words in any of the eight possible directions (4 compass directions and 
4 diagonals.)  The remainder of the puzzle is filled with letters of the alphabet that are from your 
words (making it harder to find the words), or filled with your optional secret message. It avoids 
placing words along the edges and very top/bottom rows, and avoids placing words alongside 
each other.  There are more decoy wordlets. 

8. Diabolically Difficult: Places words in any of the eight possible directions (4 compass 
directions and 4 diagonals.)  The remainder of the puzzle is filled with letters of the alphabet that 
are from your words (making it harder to find the words), or filled with your optional secret 
message. It avoids placing words along the edges and very top/bottom rows, and avoids placing 
words alongside each other.  Up to half the remaining empty puzzle space is filled with decoy wordlets. 

Note: There are fewer difficulty choices available in the Lite version of this software. 
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Advanced Difficulty Mode (Full & Pro Feature) 
Switching to this mode replaces the “basic” difficulty slider above with its individual settings below, 
letting you change each of the difficulty parameters separately.  This gives you much finer control  over 7

how your puzzle is created. 

Word directions (Arrows) 
You can choose any number of directions to place your words.  Simply tap on any of the direction arrows 
to toggle that direction “on” or “off.”  At least one direction must be left on, of course, but other than that, 
any combination of directions is allowed.  The words for your puzzle will be placed only in one of these 
chosen directions. 

 Whirlwind WordSearch may need to intelligently adjust settings if it cannot easily lay your words into the puzzle 7

you chose.  You may have a list of words and options that make it almost impossible to build the puzzle, especially 
if it has little free space.  If that is the case, then as the puzzle progress passes 40% Whirlwind WordSearch will 
continue building your puzzle, but with fewer restrictions.  That is, it will quietly turn off some of the settings you 
have chosen, to see if it has more luck in building the puzzle.  For example, if you have turned on the setting 
“Avoid laying words along puzzle edges”, if it cannot build the puzzle with that setting after about 50% of its time 
trying, it will turn that setting off and continue trying.  At 70% it will also begin removing any optional words one-
by-one as it retries.  This means that for these tightly-packed puzzles, some of your initial settings will be overruled 
and the puzzle may be built a little differently than you expect.
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Fill puzzle with: 
Here you can choose how to fill the remaining puzzle in different ways: 

• Non-Word Letters: Uses any letters from your alphabet that are not already used in your words.  
This is an “easy” mode that helps your words stand out more. 

• Only Your Fill Letters: Uses any letters from your fill letters.  This does not add any decoy 
wordlets. 

• Only Your Fill Letters+Decoy Wordlets: Uses any of your fill letters, and can add decoy wordlets. 

• Only word letters+Decoy Wordlets: Uses only letters that are used in your words. It adds decoy 
wordlets. This is a “difficult” mode that makes your words blend in. 

Amount of word overlap 
You can change how many word overlaps (word crossings) are in the puzzle. 

Easy puzzles often have some overlapping words.  This allows you to make the puzzle 
size a little smaller, with a larger font.  Setting the overlap to “lots” will attempt to 
overlap almost every word with another word, if possible.  It tries to overlap words, 
looking for identical letters shared between two words. 

Note: Setting the overlap to lots or all will, of course, cluster the words together in 
one dense area of the puzzle, which often makes the puzzle a little easier to solve. 

Harder and larger puzzles generally will have fewer overlapping words.  Thus, it may 
require a slightly larger puzzle size to fit all the non-overlapping words.  

Of course, if you request that all words overlap and you have a word that has no letters in common with 
any other words, Whirlwind WordSearch will issue a sad, quiet little sigh, roll its eyes and dice, and 
quietly place your word in a non-overlapping position instead. 

Setting the overlap to “all” will require every word to overlap some other word, and if this is not possible 
(for example, you still have that pesky word “xyzzy” that has no letters in common with any other words), 
then Whirlwind WordSearch will issue an error message. It will indicate that the puzzle could not be 
created with all words overlapping per your request. 

Allow words to overlap along same direction 
Turning this on allows overlapping words to join along the same 
direction (collinear.)  Turn this off to ensure that overlapped words will 
always be in different directions from each other.  This will make it 
easier to distinguish overlapping words on the answer key.  Otherwise, 
they tend to run together along a single line and look like a single long 
word.  This option is only available when the “Amount of word 
overlap” menu is set to something other than “None.” 

The example here shows the two words “swim” and “sand” overlapping 
in the same direction. 

____________________________________________________________________________________ 
Whirlwind WordSearch - User Guide  — Page ￼  of ￼  — Copyright © 2025, SchwanSongs80 102

a s d b e d i w d a e b b a l b a l
c d n a a d i l u n l w n u b l h a
e c l w c l a w m h a u
m a e d l d m n n h b b m b n b n u
i n s u s c l d e i l n n d i s a
w m d a h w a e b a e d a l l n b h
e c s b a l m b b a c c i d h l i
m b a l h n i e a e u w e m d n a
l w d d l l u w a n a a d b i s n i
a d a e c w i m d d i i a m w m h b i
b m h h l h m n d n a e u i i m e m a
b c a w i m l l i l m m l b i w n h m
b w e n l a e b a i i b a l n m a b b
i e u l d b i w b b w b a d l s i w h
c n a s e i b e b e w m u n a u h l i
m l h s i m m h m a a b i b b b e w m
h b h l d e h n w l b i e w w d w i m
n n e d i u c s u i w e m a e s d e e
m c b m b h m s l w w i m l w a h u i

h
c

m i w s a n d
e

b b
a
l s
l u

n

http://www.schwansongs.com


Allow words to be alongside 
If you have a large puzzle area with a small number of words, you may want the words spread out from 
each other in the puzzle, and not alongside each other.  However, if you are packing a lot of words into a 
small puzzle with very little free space left, you will need to allow the words to lay side-by-side. 

This setting lets you adjust whether words should never be alongside, or allow a little side-by-side action.  
If you set it to anywhere, then it will not check for side-by-side words at all, and let them be placed 
anywhere and thus be alongside at any time. 

Note: This is not the same as the “word overlap” setting above, which forces word overlapping 
(crossings.) 

# of “Decoy Wordlets” to Add 
“Decoy Wordlets” are short pieces of words taken from your word list, sprinkled into the puzzle. They’re 
designed to throw your puzzle solvers off the track as they look for the words.  The decoy wordlets are 
added into empty areas between your words, along with the other “fill letters.  They appear after your 
secret message has been laid in.  You can change how many of these are added, anywhere from none up to 
“lots.”  If you set it to “lots,” Whirlwind WordSearch will attempt to fill up to half the remaining empty 
space within the puzzle with these decoys.  This option is only enabled if you chose a “Fill Puzzle With”  
option that includes “Decoy Wordlets.” 

Avoid Laying Words Along Puzzle Edges 
 Turn this on to avoid laying any words completely along the edge of a puzzle. This makes a word easy to 
find.  Whirlwind WordSearch may still eventually lay a word or two along the edge if it is having trouble 
fitting all the words in overall. 

Your Fill Letters to Use (From the Chosen Alphabet) 
You can add or remove letters from this list that would normally be used to randomly “fill” the rest of 
your puzzle.  Whenever you choose the “Fill puzzle with” pop-up menu and choose items that refer to 
“fill letters,” this set of letters will be used to fill random letters.  The list is initially filled with every letter 
of the chosen alphabet, except those with diacritical letters.  You can add or delete letters that you don't 
want to use as fill letters, but you must leave at least a few letters. Otherwise, random filling won’t work.  
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Each of these letters must be from your chosen alphabet.  You may enter either upper- or lowercase letters, 
since these will be automatically convert and save as lowercase. 

For example, in French, you may want to add the letter ç to the fill-letters.  Or, if you want to fill the rest 
of the puzzle with only the letters A, B, and Z , then you would set the “Fill puzzle with” menu to “Only 8

your fill-letters…”. Afterward, set this text field to “abz.” 

Note: Whenever you change the alphabet to some other language, the fill letters text field 
automatically gets reset to the default fill letters for that new alphabet. 

Reset to Default Fill Letters 
Tapping this button will reset the fill letters text to hold every letter of the chosen alphabet, except those 
with diacritical letters.  It will overwrite whatever letters are in there. 

Tip: If you want to quickly add in all the diacriticals, you can simply tap the “Words" tab. Select, copy 
and paste the entire alphabet line from the “Alphabet/Font Example” display. Then, paste the list of 
letters here. 

5.14. Printing - Tab 

This tab contains many more fine-tuning options for how your printed puzzle and answer pages can be 
arranged.  These settings will not affect your exported puzzle files; only your printed output. 

Note: To “preview” what your printed puzzle will look like on the page 
without having to print it first, choose Print. At the bottom of the print 
dialog, choose “PDF: Open in Preview.” There you can see the final 
puzzle/answer pages printed to a separate PDF document on-screen. 

 Perhaps your name is Uncle Shelby.8
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5.15. Printing:Page Layout - Tab 

Arrangement 
This allows you to choose the page’s orientation, portrait (tall) or landscape (wide). As expected, this 
changes how the puzzle and word list will be laid out.  This setting affects how the puzzle and answer are 
printed, but does not affect how they are exported. 

Footers 
Print puzzle separator lines: Turn this on to print separator lines between title, puzzle, and word list on 
the printed puzzle and answer pages.  Turn this off if you do not want any separator lines printed there.  
This applies to export too, but only when you turn on the “including Ttitle and Word List” option. 

Print a footer line (Application name and swan logo): Turn this on to display a footer line with the 
application’s name and company logo at the bottom of the printed puzzle and answer page. 

Note: The “Print a footer line” option is always on in the Lite version of this software. 
Print SPIN # in footer line: Add the puzzle’s SPIN # to the footer line.  For more information on the 
SPIN #, see this section. 
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5.16. Printing: Puzzle Page - Tab 

Puzzle Page Printing 
Print the Puzzle Page: Turn this on to print the page containing only the puzzle.  Turn it off to 
completely skip printing of the puzzle page. For example, you may just need to re-print the answer page. 

5.17. Printing: Answer Page - Tab 

Answer Page Printing 
Print the Answer Page: Turn this on to print the page containing the answer key.  Turning this off will 
skip printing the answer key page altogether.  This is useful if you have already printed it and don't need 
to print it again. Likewise, skip this step if you haven’t a need for the answers but only the puzzle. 

Print all non-answer letters: This lets you choose how the answer key is filled with “non-answer 
letters.”  The remaining letters can either be NEVER shown, or they can be shown in a DIMMED gray 
color. Alternatively, they can be shown ALWAYS, or the same color as the answer letters.  Note that, if 
you set this to NEVER, then the grid lines will be forced back on for the answer key. This helps you see 
where the words are relative to the puzzle. 

Highlight 'regular’ hidden words on answer page: Normally, any words that you have marked as 
“hidden” (with a leading asterisk) in your word list will be hidden (not printed) in the word list and will be 
hidden in the answer key.  Turning this on will show (and print) the hidden words in the answer key, and 
they will be highlighted with an oval background.  They will still be omitted from the printed word list. 
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Highlight 'extra’ hidden words on answer page: Normally, any words that you have added in the 
“Extra-Hidden-Words” tab of the Settings dialog will be hidden (not printed) in the word list and will be 
hidden in the answer key.  Turning this on will show (and print) the extra hidden words in the answer key, 
and they will be highlighted with an oval background.  They will still be omitted from the printed word 
list. 

Answer Highlighting 
Style: You can highlight the answer key words with “open ovals,” “solid 
ovals,” or “strike-through lines” - whichever you prefer. 

Line width: You can adjust the size/thickness of the line to make it thinner 
or thicker than the regular size. 

Open oval width: If you chose the “open oval” style, you can widen or 
narrow the width of the oval/loop a bit, to your liking. 

Highlight color: Tap the color wheel to pick a new color for the oval/strike-through lines drawn along the 
placed words in the answer key. 
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5.18. Stats - Tab 
This tab displays a number of statistics about the generated puzzle.  If no puzzle has been created yet, then 
this page will be empty. 

Puzzle Shape: The name of the puzzle shape you chose. 

Puzzle Size: The width and height of the puzzle in letters. 

Puzzle Alphabet: The name of the alphabet you have chosen to use for the puzzle words. 

S.P.I.N.: The Specific Puzzle Identification Number. It’s used to exactly re-create a particular puzzle 
layout.  See this section link for more SPIN information. 

Puzzle Build Time (%): How long it took before finding an answer, as a relative “percentage” of the total 
allowed number of attempts. 

Difficulty: The level of difficulty used (one through eight, or “advanced”.) 

# Word List Words Total: A count of how many total (non-hidden) words you typed in your word list.  It 
includes all the words you typed whether they got placed in the puzzle or not. 

# Word List Words Shown: A count of the number of words that are displayed in the puzzle's final word 
list.  This is the number of words the user expects to find in the puzzle, so it does not count hidden or 
dropped optional words. 

# Dropped Optional Words: A count of how many +optional word list words that could not be placed 
into the puzzle. Ultimately, these were dropped from the list.  

# Words in Direction —: A count of how many word list words (for one of the eight layout directions) 
that got placed into the puzzle. 

Total # Letters from Words: A count of how many total letters you used across all the words in your 
word list. 

Unique Letters from Words: A consolidated list of each unique alphabetic letter used across all the 
words in your word list. 

Total # Unique Letters from Words: A count of how many total unique letters you used across all the 
words in your word list. 
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# Decoy Wordlets Added: While the puzzle is being created in the highest difficulty modes, the software 
sprinkles some pieces of each of your word list words as “decoys” into the puzzle, to trick the puzzle 
solver.  This number is a count of how many decoy wordlets were added.  The positions of these added 
partial words can be shown in the preview window by turning on the “Show Decoy Wordlets” checkbox, 
described at this section link. 

Total Overlapping Letters: How many letters overlap (i.e. are shared between words) in the puzzle. 

Total Letters in Puzzle: A count of how many letter spaces there are in the current puzzle's shape.  For a 
10x10 “square” shape, this would be 100 (10 wide by 10 high.)  For a 10x10 “circle", it will be a little less 
(76) since the rounded corners are not filled with letters. 

Remaining Spaces in Puzzle: A count of how many letter spaces there are in the current puzzle's shape 
which are not part of the placed words.  This is a count of all the empty spaces between the words. These 
normally get filled with random letters, or with your “secret message.”  Although this number can vary by 
a few spaces each time you make a new puzzle, it gives a good idea how many letters are available for the 
“secret message phrase” if you want it to exactly fill that space. 

Percentage of Puzzle Filled: The total percentage of letters in the puzzle that are filled with letters from 
your words, or in other words, how densely the puzzle is filled with your words.  The higher the 
percentage, the longer it will take to generate the puzzle. 

# of Zapped Duplicate Words: A count of how many duplicate words it found and removed from the 
generated puzzle.  These “eliminated” word positions can be shown in the preview window by turning on 
the “Show removed dupe words” checkbox, described at this section link. 

# of Zapped Naughty Words: A count of how many naughty words it found and removed from the 
generated puzzle.  These “eliminated” word positions can be displayed by turning on the “Show removed 
'Naughty Words'” checkbox in the Preview window.  Of course, if you are making a word search puzzle 
with a list of naughty words, those naughty words you intentionally added in your word list will remain in 
the puzzle. After all, you wanted them there! 

Total Naughty Words to check: A count of how many naughty words that Whirlwind WordSearch knows 
about. It can eliminate for the language you chose.  This includes any “excluded words” you added in the 
Settings window. 

Secret Message Text: The actual text from your secret message.  This line will only show if you have 
some text for a secret message. 

Secret Message Position: Top/Middle/Bottom/Exact Fit.  This line will only show if you have some text 
for a secret message. 

Secret Message Length in puzzle: The total number of letters in the text from your secret message.  This 
line will only show if you have some text for a secret message. 
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5.19. Preview on the Right 
The right side of the window displays a preview of the generated puzzle, or its answer key.  If you create a 
new puzzle, or make changes to the puzzle in the various tabs, they will be shown here. 

This shows what your puzzle and answer will look like when you print or export.  It also shows the 
optional puzzle title, subtitle, separator lines, and word list which will be printed around the puzzle.  You 
can always tap the “build” button again until you see a puzzle layout that you like before you decide to 
export or print  it. 

As you change the layout settings (e.g. Letter Font, Gridlines, etc.) this preview area will immediately 
update to show your changes. 

Preview Display: 

Puzzle/Answer radio buttons: Choose the “Puzzle” radio button to see the puzzle, without highlighting 
its answer.  Choose “Answer” to display what the answer key will look like, displaying the positions of 
the words using your chosen answer highlight style 

Checkboxes:  Above the preview display are some checkboxes that can add some display details to the 
preview area.  Changing these checkboxes does not affect the final printed or exported puzzles, only what 
is shown in this preview window.  These controls can show some of the extra “behind-the-scenes” work 
that Whirlwind WordSearch does to create your puzzle. 
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Show secret message: Turn this on to highlight your secret message with a gray background in each cell.  
If it’s turned off, then the secret message will not be specially highlighted this way. Rather, it will simply 
look like all the other random fill letters. 

Show Hidden Words: Turn this on to highlight (in a gray answer highlight style) any words you marked 
as “hidden.”  This will show both your “regular” hidden words, and any “extra-hidden” words you set up 
via the Settings dialog.  Toggling this setting only affects the preview display.  To show or hide the hidden 
words in your printed or exported output, use the checkboxes under the Printing:Answer Page: tab 
mentioned in this section. 

Show Removed “Naughty Words": Turn this on to highlight (in light red strike-through) any “naughty 
word” that was detected and removed or altered during the puzzle-making process.  The displayed word 
will already have been “altered.” Therefore, it is no longer“naughty.” Of course, any naughty words that 
you intentionally added into your word list will remain in the puzzle, since you wanted them there. This 
only removes naughty words that were randomly added when filling the rest of the puzzle.  The internal 
list of naughty words that are detected is based on which alphabet you chose to make the puzzle along 
with any that you add via the Settings dialog. 

Show “Decoy Wordlets": Turn this on to highlight (in light green strike-through) any partial “decoy 
wordlets” that were added during the puzzle-making process.  

Show removed duplicate words: Turn this on to highlight (in light blue strike-through) any 
accidentally-randomly-created duplicate of one of your words that was found during the puzzle-making 
process. These words were either altered or removed. 

Show # Unused Optional Words:  If there were optional words in your word list that were not used but 
removed in order to create the puzzle, this button can be enabled. It is displayed just under the preview 
checkboxes.  Click it to bring up a dialog which lists 
any unused optional words.  You can select and copy 
this list from the dialog, in case you want to paste 
these words into a new puzzle’s word list.  Once a 
puzzle is built where all the optional words were 
successfully placed, this button will be disabled. It 
will simply say: “All Words Used.” 
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5.20. Buttons Along the Bottom Right 

More Goodies for You! Button 
This button opens a window displaying a list of my other software products and published books. Each 
has a short description.  Simply tap one of the product rows. It will immediately open your web browser 
to a page that fully describes that product, and how to get it. 

Help (User Guide) Button 
The circled-question-mark button is a “help” button. It opens a window with this user guide 
displayed for quick access.  It is the same as choosing “User Guide” from the Help menu. 

Note: While the user guide window is open, you can tap any "table-of-contents" page number to jump 
to that page.  To search for a word or phrase, enter thattext in the Search field.  You can type the 
<Return> key to find the next occurrances of that text. 

Export Button 
After building the puzzle, you can immediately export the puzzle and answer by tapping the “Export” 
button in the lower-right corner of the document window.  You can also choose “Export Puzzle” from the 
“File” menu, or tap ⌘-1.  This will bring up an export dialog, letting you choose the destination directory 
and a number of other options.  See the export section for more information. 

Print Button 
After building the puzzle, you can immediately print it by tapping the “Print” button in the lower-right 
corner of the document window.  You can also choose “Print” from the File menu, or tap ⌘-P.  This will 
bring up the standard print dialog, letting you choose the printer, page layout, number of copies, etc. 
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Before you print the pages, you can configure what to print and how the page looks. For example, the 
page title, footers, and whether to print the word search puzzle or the answer page (or both).  You can do 
this from settings under the main window’s “Layout” tabs, described above. 

Build Button 
After configuring the puzzle, you can tell the software to build it by tapping the “Build” button in the 
lower-right corner of the document window.  You can also choose the “Build the puzzle” menu item on 
the action menu, or type ⌘-B. 

Once the puzzle begins building, a progress window will display: 

As it tries laying in your words to match the difficulty rules you chose in millions of different positions, it 
shows the progress as a percentage.  This could take anywhere from a few seconds to a minute or two, 
depending on how large or complex the puzzle is.  If you want to stop the building of the puzzle, simply 
tap the “Cancel” button. The puzzle will stop building and be cleared.  You can then make adjustments 
and try building it again. 

If you don’t like the final answer layout for the currently built puzzle, simply tap the “Build” button again.  
Each time you tap it, a new puzzle will be made with a completely different layout of your words. 
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5.21. Menus at the Top 
The menu items along the top “menu bar” contain special commands for opening/closing/printing your 
documents, etc.  You won’t need to use them too often, but the menu items that are specific to Whirlwind 
WordSearch are explained here. 

>“Whirlwind WordSearch” - Menu 

About Whirlwind WordSearch 
Choose this item to display a window that gives credit to all the people who helped make this software 
happen. Watch them scroll by and wave as you listen to the fun parade music I wrote, or if you have the 
Pro version, dance to my waltz music. 

Settings  9

Choose this item to open a window that lets you change application-specific settings. When you set the 
values here, they are used for all future runs of Whirlwind WordSearch. They are used for any of your 
documents, until you change them again here. 

Appearance 
Textured window background: Turn this on to add a wood-grain finish to the windows.  Turn it off to 
have a flat finish.  This is aesthetic and only affects the screen view, and does not affect the printed/saved 
puzzles.  This setting change is immediately remembered. All future documents and launches of the app 
will use your new setting.  Unlike the other document-specific settings, this is saved for the application. 
Therefore, it will affect the look of the windows, no matter which documents you open.  After fifty years, 
it is time for wood grain finishes to be popular again. (However, orange and avocado-green are forever 
gone.) 

Do puzzle progress animation: Turn this on watch the animated attempts to insert words in the preview 
area while building puzzles.  This works by showing a snapshot of every 1,000th attempt to lay out the 
words in the Preview area as it works through many many many (many) possibilities of word positions. 

 Apple changed the menu item name from its original “Preferences” to “Settings” (in MacOS 13/ Ventura) to 9

better align with iPhones, because, well, you know, “a foolish consistency is the hobgoblin of small minds.”
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Automatically show weekly user tips: This will cause Whirlwind WordSearch, once a week, to open with 
a little window with an interesting tip or suggestion for things you can do with this software.  Each week a 
new tip will be displayed.  Turn this off to permanently silence the dialogs.  You can always manually read 
the next one by choosing “Next User Tip” from the Help menu. 

Disable/Enable Tooltips: You know those useful text pop-ups that 
help you learn what each item is before you click on it by floating 
the text under your mouse cursor?  After using the software for 
awhile, you may want to turn those off, since they sometimes 
cover up what you are trying to look at.  Now you can!  Well, you 
can now turn most of them off… the ones on the main document 
window, the main menu, the export window and bulk-builder 
window.  Simply tap the “Disable Tooltips” button, and (after 
reading the note) quit and re-start the software, and from now on, 
the tooltips will be gone.  If you want them back, simply repeat this process, as the button will now say 
“Enable Tooltips”. 

Extra Hidden Words (Full & Pro Feature) 
You can add extra words here that will always be added to every puzzle you make. Like your other hidden 
words, these will not highlighted in the answer key.  You can have a different set of words for each 
language/alphabet you choose.  Each word must be on a separate line and must only consist of letters from 
the currently chosen language/alphabet.  This can be useful for adding your name or company name into 
every puzzle you make. It can used as a kind of anti-theft watermark, for example. 

Note that it is possible to accidentally add a word that is too long or has letters from other than your 
currently-chosen alphabet or is a duplicate of other words in your word list.  These problems will be 
detected later when you try to build the puzzle, and an error message will be displayed. 

Excluded Words (Full & Pro Feature) 
There is currently a built-in list of “naughty words” for which your puzzles are scanned. These are 
removed if they are randomly created from the extra fill letters in your puzzle.  Now you can extend it 
with your own set of “excluded words”, in case you have your own particular slang/derogatory words you 
don’t want to accidentally get created in your puzzles. 

You can have a different list for each language/alphabet you choose. Each word in the list must be on a 
separate line and must only consist of letters from the language/alphabet you choose.  If a word in your 
list has letters from other than your currently-chosen language/alphabet, or is a duplicate of one of the 
built-in known bad words, then it will be quietly ignored. 

Author Info (Full & Pro Feature) 
When you export your puzzles, you will likely want to insert your name and copyright information into 
the exported files as a way to protect/watermark your work.  Some of the export formats support this 
embedded information, specifically IPUZ, SVG, ESP Files, and the Text info files.  You can enter your 
information here. By doing so, it will be added to every file you export. 
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SVG Export (Full & Pro Feature) 
When you export your puzzles in “SVG” format, that file will include your specific font name for the title, 
letters and word list, as well as substitute or fall-back fonts to use in case your specific font choice is not 
available on the destination user’s computer.  Since you have no control over which fonts other people 
have on their computers, SVG can supply additional general-purpose “fall-back” fonts. 

Add “Fall-back” fonts to SVG text: When you are creating SVGs to display directly on the web, you 
will want to turn on the “fallback fonts” that will be substituted if your font isn’t there. 

However, if instead you are directly importing your SVG files into another publishing/page layout 
program on your computer (e.g. InDesign or Affinity Publisher) and you will then be exporting them all to 
a final PDF file, then you don’t need to specify other “fallback fonts” in case yours is missing.  In this 
case, you should turn off the “Add Fall-back…” checkbox. 

Below that you can choose which fall-back fonts which will closely match your chosen font for the title, 
letters, and word list.  The font styles you choose here will be used for all future SVG exports. 

Below that is a legend showing an approximate example of the fall-back font styles listed in the pop-up 
menus above, for reference. 
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Extras (Full & Pro Feature) 
Puzzle Grid Aspect Ratio: 

There may be the rare occasion when you might want the printed or exported puzzle grid to be slightly 
stretched to be a little wider than tall, or a little taller than wide.  This allows you that fine adjustment.  
Changing the Width adjustment to 80% makes the puzzle width 80% of its height.  The normal setting for 
exactly square cells is 100%.  This adjustment will affect the all your printed and exported puzzles. 

Save Document Settings as Defaults 
Choose this item to take and save a “snapshot” of the current document's settings (including title, subtitle, 
puzzle size & shape, printing options, word list, etc.).  Afterward, all new documents you create with 
Whirlwind WordSearch will start with these default settings.  This can be useful if you find that you have 
certain settings that you always want for your projects, e.g. certain fonts, colors or grid line settings or 
answer highlight styles. 

Note: It saves all your document settings, including your word list, puzzle title/subtitle, secret message, 
and puzzle layout.  You will probably want to clear these prior to selecting this menu option, to create a 
cleaner snapshot. 

Reset Document Settings to Defaults 
Choose this item to reset all the current document's settings to the saved default settings (including title, 
maze size & shape, printing options, etc.) 

Note: This only affects the currently open document settings, and does not change the settings for 
newly opened documents.  To reset the settings for all future new documents, immediately select the 
“Save Document Settings as Default” menu item after selecting this menu item. 

Change Current Colors to B&W 
Choose this setting if you are printing a black-and-white book or worksheet, It will quickly change all 
font/grid colors to black and white (and gray). 

Note: This changes the colors in the currently opened document, and does not save them for other 
documents.  If you want all future new documents to have this setting, then immediately select  “Save 
Document Settings as Default” after selecting this menu option. 
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Pro Upgrade… 
This menu item allows you to purchase an in-app upgrade.  Immediately it gives you all the extra features 
available in the Professional (Pro) version of this software.  For details, see this section. 

>“File” - Menu 

New 
Creates a new empty document window, where you can build a new puzzle. Save your puzzle document 
as a file if you want to open it later.  You can have multiple windows open at once, switching between 
each of them periodically. 

Open/Save (Full & Pro Feature) 
This allows you to save an existing puzzle to a file (including the word list and all your settings), or re-
open it.  These files can also be sent to other Whirlwind WordSearch users. Then they, too, can then open 
and use the puzzle.  These special files can only be opened by Whirlwind WordSearch. 

Revert to> (Full & Pro Feature) 
As you build puzzles from a document, you can periodically Save your changes to the current document. 
It will be remembered as a “snapshot” or “version.”  Later on, you can choose this menu item to bring up 
a list of these past saved versions of this document. Choosing one will instantly restore it back to one of 
those prior saved file versions.  Use this feature to “rewind” back to an earlier puzzle layout you might 
have liked best. 

Export Puzzle… 
Choose a file name, and in turn, an image of the puzzle (and optionally an image of the answer) will be 
converted and saved.  This item will be disabled if you have not yet built a puzzle.  You can export only 
the puzzle image, or both the puzzle and answer images together.  See the export section for more detailed 
information. 

Print 
This opens the print dialog and allows you to print one or more copies of your puzzle page (and/or answer 
page) to a printer. 
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>“Edit” - Menu 

Copy Formatted: (as image) 
Choose one of these to copy a (PDF) graphic image to the clipboard.  These items will be disabled if you 
have not yet created a puzzle.  Capturing each element of the puzzle this way can be useful if you are 
quickly setting the puzzle page in your own layout, and want the puzzle, word list, answer grid, etc. in 
different positions on the page. 

Puzzle Grid as Image 

Answer Grid as Image 

Word List as Image 

Word Direction Arrows as Image 

This copies a square image of direction arrows, where each of the eight arrows will be shown 
if there are any words in the currently built puzzle that lay along that direction.  This can be 
used as an extra clue or legend on the puzzle page for easier puzzles. 

Copy Formatted: (as text) 
Choose one of these to copy a (PDF) graphic image to the clipboard: the puzzle grid, the answer grid, or 
the word list.  These items will be disabled if you have not yet created a puzzle. Copy Formatted : 
Puzzle Grid as Text 

Answer Grid as Text 

Word List as Text 

These are most useful if you wish to extract the raw puzzle text, and do your own fancy formatting.  The 
puzzle and answer grid of letters are written in a tab-delimited format.  This text can be easily pasted into 
word processors or spreadsheet programs for further formatting. 

Note: When you choose the menu item File:Export and turn on the “and Info Text File” option, it will 
include the puzzle and answer grids written in two different text format styles (tab and comma-
separated.)  For more information, see this section. 

Spelling and Grammar 
These menu items can offer you a visual indication of any misspelled words you either type in the word 
list or the secret message text areas. It also checks for misspelled words in the title and subtitle.  You can 
select “Check Spelling While Typing” here.  Any word that is unrecognizable by the dictionary will have 
a red underline beneath it. 

>“Action” - Menu 

Build the Puzzle 
This generates a word search puzzle from the words and settings you have chosen.  It’s equivalent to 
tapping the Build button on the main window. 
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Stop 
Choose this to interrupt and halt the creation of a word search puzzle in progress.  This is the same as 
tapping the Cancel button in the “Building…” progress sheet. 

Shape Editor… (Pro Feature) 
Design your own custom shapes and use them to create puzzles. You can read how to use this powerful 
feature in the section linked here. 

Bulk Builder… (Pro Feature) 
Choose this to open the Bulk-Builder tool window.  You can read how to use this powerful feature in the 
section linked here. 

>“View” - Menu 

Enter/Exit Full Screen 
Toggle the main window between regular size and full-screen mode. 
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>“Help” - Menu 

Whirlwind WordSearch User Guide 
This menu item opens a window that displays this user guide document.  Adjust the size of the text by 
making the window larger or smaller.  Print a copy of this user guide by choosing Print from the File 
menu. 

Tap the “Save to PDF file” button to save a 
copy of this user guide as a separate PDF 
file.  You can then open it in a nicer PDF 
viewer, or copy it to another device for later 
viewing. 

While the user guide window is open, you 
can tap any "table-of-contents" page 
number to jump to that page. 

To search for a word or phrase in the 
document, enter that text in the Search field 
at the top.  You can type the <Return> key to find the next occurrances of that text. 

Whirlwind WordSearch Introduction 
This menu item displays a multi-tabbed quick introduction, illustrating some of the features of the 
software.  It opens each time you run the software, unless you un-check the “Show this window on 
startup” box at the bottom of the window.  You can always open it later, by choosing this menu item. 

Bulk-Builder Guide (Pro Feature) 
This menu item opens a window displaying a document showing you how to enter the large lists of words 
when generating many puzzles via Bulk-Builder.  These lists can be used in the Bulk Word-List tab of the 
Bulk-Builder. 

ESP File Export Guide (Pro Feature) 
This menu item opens a window displaying a document explaining the special ESP File format available 
in the Export window of the Pro product.  This exported file format captures the entire puzzle and answer 
in a single easily-readable file, and can be used for advanced publishing workflows or as data to power 
your own interactive web puzzle games. 

What’s New 
This menu item displays a detailed list of all the new features in this software release.  There is also a list 
of known bugs, in case you find something acting strangely and want to see if I already know about it.  
Moreover, there are notes on prior releases. 

Next User Tip 
This opens a little window with an interesting tip or suggestion for interesting things you can do with this 
software.  Each time you choose this menu item, a new tip will be displayed. 
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Feature Comparison 
This menu item displays the feature differences between the Lite and Full and Pro versions of this 
software. 

Contact Author 
This menu item opens a pre-formatted e-mail. You can easily send me an update with any questions, bugs, 
or feature requests.  It automatically contains some information about which version of this software you 
are using.  Having this information helps me answer your questions. 

Rate/Review Whirlwind WordSearch 
This menu item opens an Apple App Store window. It lets you add your rating, and write a review for this 
software.  By doing this, you are letting others know how you like it.  Please consider rating it and also 
possibly writing a sentence or three about it! 

Whirlwind WordSearch Product Web Page 
This menu item opens a browser window that displays the product web page for this software. 

More Fun Products 
This menu item opens a window that displays a list of many of my other software products and published 
books. Each has a short description.  Simply tap one of the product rows, and it will immediately open 
your web browser to a page that fully describes that product, and where to get it. 

Company Web Site 
This menu item opens a browser window that displays my company web page, showing my other 
products and myriad interests. 
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6. Writing Word Search Software is Easy, Right? 
When I began writing this software many years ago, I thought a word search program would be fairly easy 
to create.  After all, the software just needs to lay a list of words randomly into a grid, and fill the rest of 
the empty spaces with random letters.  What's so tricky about that? 

As it turns out, some of the free word search web sites and applications out there do just this, and you get 
what you pay for.  However, I quickly found that there were some rather interesting, subtle and complex 
problems that arise with those generated puzzles if you just stop there. 

For example, every once in awhile, those randomly sprinkled letters will happen to accidentally create 
another copy of one of your own word list words in the puzzle. Uh oh, people will find their word in two 
places, not one. Or worse, they will just find the wrong one, and tell you that your answer key is incorrect!  
So, how did I fix this?  After generating a puzzle, my software searches the entire puzzle grid in all 
directions looking for duplicate copies of each word, and if it finds a randomly created duplicate word, it 
changes a letter or two to something else.  It then re-checks the entire puzzle again in case that change in 
turn creates a duplicate of some other word.  It repeats this “clean-up” until no more problems are found. 

Or how about this one… sometimes those random letters will form “naughty words.”  Uh oh!  Perhaps the 
students may snicker and enjoy finding them, but teachers and parents may not find them so humorous on 
a school handout.  So my software searches for and removes any of these accidentally formed words too.  
But hold on… the software can make puzzles in different languages!?  Yes, you guessed it.  It must have a 
list of “naughty words” in each language as well!  By the way, the research I had to do to obtain lists of 
dirty words in many different languages is probably worthy of a short humorous novel of its own. 

Here is a problem that seems quite simple to the user but turns out to be quite 
complex to the software engineer: how to correctly handle the “Allow Words to 
Overlap/Share Letters" feature.  If I simply checked for two words that share one 
or more letter grid spaces, that is easy.  But words can also cross over or between 
each other at diagonals, such that they don't actually “share” any letters.  How do 
I detect these?  It turns out there are some elegant geometry calculations for 
“Determining if two line segments intersect.” So, I chose one and got it working 
(in C++) to find out if words “overlap.”  My high school teacher was right when 
he said I would need that geometry someday! 

Many other important “finishing touches” were needed to make this software something I am proud of; 
for example, using terse “user interface” wording on each of the checkboxes and buttons that make sense, 
writing and updating this giant user guide, adding Pro features like user shapes and bulk-building, testing 
the software to find and fix yet more complex problems… it is quite a labor of devilishly detailed love.  
And I hope you love it too!  If you do, let me know. Write a review… and tell your friends! 

And if you don’t love something, let me know that too.  Please tell me if anything is broken or confusing. 
I will endeavor to fix it.  If you have more ideas for what you would like to see changed or added, please 
read the next section below :-) 
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7. More Information, What's Next? 
What new things will be added to this software?  Some of that is up to you, the user of this software.  Feel 
free to let me know what features you would most like to see, and I will collect your requests and work on 
adding the most-requested features into future updates.    I have had many people suggest new features or 
changes over the years, and I continue to add the most requested ones as free updates.  Please send your 
suggestions, critiques, or kudos to note@schwansongs.com or schwansongs@gmail.com 

Here are some features that are already on my to-do list.  Tell me which you want to see! 

• Choose other grid line styles/patterns. 

• Other export formats and options. 

• Add more alphabets/languages . 10

• More Pro features 

• Automagically create/load a “daily puzzle” (different each day.) 

• Disclose more of the secret “easter egg” features . 11

• Make your own iPhone/iPad “game” that interactively plays these puzzles (see this section.) 

• Have some built-in themed word-lists that can be auto-loaded (ahem, in each language.) 

• More puzzle-macros (see this section.) 

• Make a “universal language” option to mix multiple languages into one puzzle.

 Send me an e-mail if you want to help me add your favorite language!10

 You mean like the one where you hold the option key down and click on the icon in the upper right corner?11
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